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Safety warning notice
WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on
a hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to
contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer
and the AC adapter comply with the user-accessible surface temperature limits defined by the
International Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description

Product Name HP EliteBook 8770w Mobile Workstation

Processors Next Generation Intel® Core™ i7 processors, (support Intel Turbo Boost Technology):

● i7-3520M, 2.90 GHz (Turbo up to 3.60 GHz), 1600 MHz, 4 MB L3 Cache, 4 threads, 35W

● i7-3610QM, 2.30 GHz (Turbo up to 3.30 GHz), 1600 MHz, 6 MB L3 Cache, 8 threads, 45W

● i7-3720QM, 2.60 GHz (Turbo up to 3.60 GHz), 1600 MHz, 6 MB L3 Cache, 8 threads, 45W

● i7-2820QM, 2.3 GHz (turbo up to 3.4 GHz) quad-core processor, 8 MB L3 cache, 8 threads,
45W

● i7-3820QM, 2.70 GHz (Turbo up to 3.70 GHz), 1600 MHz, 8 MB L3 Cache, 8 threads, 45W

 Next Generation Intel® Core™ i5 processors, (support Intel Turbo Boost Technology Technology):

● i5-3320M, 2.60 GHz (Turbo up to 3.30 GHz), 1600 MHz, 3 MB L3 Cache, 4 threads, 35W

● i5-3360M, 2.80 GHz (Turbo up to 3.50 GHz), 1600 MHz, 3 MB L3 Cache, 4 threads, 35W

Chipset Mobile Intel QM77

Graphics Support for the following graphics subsystem graphics boards (all feature OpenGL driver support):

● AMD FirePro M5950 XT-GL 1GB GDDR5 (DP 1.2 and Eyefinity Plus support)

● NVIDIA Quadro 3000M, N14E-Q1 2 GB dedicated GDDR5 video memory

● NVIDIA Quadro 4000M, N14E-Q3 2 GB dedicated GDDR5 video memory

● NVIDIA Quadro 5010M, N14E-Q5 4 GB dedicated GDDR5 video memory

Display ● Display panel, 43.9 cm (17.3 in), High Definition Plus (HD+) Anti-Glare (AG) LED WVA without
webcam

● Display panel, 43.9 cm (17.3 in), FHD AG LED WVA

● Display assembly, 43.9 cm (17.3 in), FHD AG RGB LED UVWA Dream Color with webcam (not
available with HP Mobile Broadband) (includes display panel cable, 3 WLAN antenna and
cables, and 2 WWAN antenna and cables)

● Display assembly, 43.9 cm (17.3 in), FHD AG RGB LED UVWA Dream Color without webcam
(not available with HP Mobile Broadband) (includes display panel cable, 3 WLAN antenna and
cables, and 2 WWAN antenna and cables)

Memory 4 customer-accessible/upgradable memory module slots

 Supports dual-channel memory

 Supports up to 32,768 GB of system RAM

 DDR3 1600MHz PC3-12800 SODIMMS
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Category Description

 Supports the following configurations:

● 2048 MB total system memory (2048 × 1)

● 4096 MB total system memory (4096 × 1)

● 4096 MB total system memory (2048 × 2)

● 8192 MB total system memory (8192 × 1)

● 8192 MB total system memory (4096 × 2)

● 8192 MB total system memory (2048 × 4); only available on computer models equipped with a
quad-core processor

● 12288MB Total System Memory (4096MB x 3)

● 16384 MB total system memory (8192 x 2)

● 16384 MB total system memory (4096 x 4); only available on computer models equipped with a
quad-core processor

● 32768 MB total system memory (8192 x 4); only available on computer models equipped with a
quad-core processor

Primary and
secondary storage

Supports 7.0 mm (0.28 in), 9.5 mm (0.37 in) or 12.7 mm (0.5 in) hard drives and 6.35 cm (2.5 in)
solid-state drive for primary and secondary storage.

 Support for RAID 0/1/5

 Supports the following Serial ATA (SATA), 7200-rpm drives:

● 750 GB

● 500 GB

● 320 GB

● 500 GB self encrypting drive (SED)

 Supports the following 6.35 cm (2.5 in), solid-state drives (SSD):

● 256 GB Self Encrypting Drive (SED)

● 128 GB

● 160 GB

● 180 GB

● 24 GB

Upgrade bay  

 Supports the following 12.7 mm 6.35 cm (0.5 in) tray load SATA optical drives:

 ● Blu-ray R/RE DVD±RW SuperMulti Double-Layer (DL) Drive

● ±RW SuperMulti Double-Layer Drive

● DVD±RW SuperMulti Double-Layer Drive

● DVD-ROM Drive (defeatured combo)

 Supports a 7.0 mm, 9.5 mm, or 12.7 mm 500 GB hard drive, 7200 rpm

 Supports "No Drive" option

Audio and video Integrated dual-array microphone

 High-definition (HD) audio with SRS premium sound

2 Chapter 1   Product description



Category Description

 2 stereo speakers

 Integrated 720p HD webcam

Modem 56K V.92 data/fax modem

 Supports “no modem” option

 Modem cable not included

Ethernet Intel® 82579LM Gigabit Network Connection

 S3/S4/S5 wake on LAN

 NIC power-down technology

 Ethernet cable not included

Wireless Integrated wireless local area network (WLAN) options by way of the following wireless
modules:

 ● Intel® Centrino™ Advanced-N 6205, 802.11a/b/g/n WLAN module

● Intel Centrino Ultimate-N 6300, 802.11a/b/g/n WLAN module

● Broadcom 802.11a/b/g/n 2x2WiFi Adapter

 Three WLAN antennas (3) built into display assembly

 Support for “no WLAN” option

 Integrated wireless wide area network (WWAN) options by way of the following wireless
modules: (not available on computer models with Dream Color displays)

 ● HP hs2340 HSPA+ Mobile Broadband Module

● HP un2430 EV-DO/HSPA Mobile Broadband Module

● HP hs2350 HSPA+ Mobile Broadband Module (not available with Win8 or Win7 downgrade )

● HP hs2350 HSPA+ Mobile Broadband Module (not available with Win8 or Win7 downgrade )

 WWAN antennas (2) built into display assembly (worldwide, 5-band)

 Support for “no WWAN” option

 Security provided by subscriber identify module (SIM) located inside battery bay

 HP Integrated Module with Bluetooth 4.0

 Support for “no WPAN” option

External media
card

One ExpressCard slot, supporting 16-bit and 32-bit (Cardbus) ExpressCard modules

 Digital Media Card reader, supporting the following formats:

● MultiMediaCard (MMC)

● MultiMediaCard Plus (MMC+)

● Secure Digital (SD) Memory Card

● Secure Digital High-Capacity (SDHC) Memory Card

● Secure Digital Extended Capacity (SDXC) Memory Card
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Category Description

Ports ● 1394a (1)

● Multi-pin AC port

● Audio in (mono microphone)

● Microphone input (stereo)

● Audio-out (stereo headphone)

● Display port (1.1a for NVIDIA, 1.2 for AMD)

● Docking connector

● eSATA/USB 2.0 combo

● RJ-11 (modem)

● RJ-45 (Ethernet, includes link and activity lights)

● USB 3.0 (2)

● USB 2.0 (2) 1 port with USB charging support

● VGA (Dsub 15-pin) supporting 1600 × 1200 external resolution at 75 GHz (hot plug/unplug with
auto-detect)

Docking Supports the following docking stations:

● HP 230W Docking Station

● HP 230W Advanced Docking Station

● HP USB 2.0 Docking Station

● HP Essential USB 2.0 Port Replicator

● HP LAN and USB Travel Hub

Keyboard/pointing
devices

36.5 cm (14.4 in) full-size keyboard with separate numeric keypad, Dual Point (3 pointing stick
buttons and 3 TouchPad buttons) without backlight

 36.5 cm (14.4 in) full-size keyboard with separate numeric keypad, Dual Point (3 pointing stick
buttons and 3 TouchPad buttons) with backlight (not supported in Japan or Brazil)

 Spill-resistant DuraKeys coating

 Spill-resistant DuraPad coating on TouchPad

 Gestures enabled by default - 2 finger scrolling, 2 finger zoom (pinch)

 TouchPad supports vertical scroll zone

 Taps enabled as default

Power
requirements

Supports the following AC adapters with localized cable plug support:

● 200W Slim Smart AC adapter

● 230W Slim Smart AC adapter

● 230W Smart AC adapter

● 3-wire plug (with ground pin)
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Category Description

 Support for the following batteries:

● 8-cell, 2.8 Ah (83 WHr) Li-ion battery

● 8-cell, 2.8 Ah (75 WHr) Li-ion battery (available with 3 year warranty only)

● Supports 9-cell (73 WHr) polymer, HP ST09 Extended Life Battery (does not support HP Fast
Charge)

● Supports 9-cell 3.0 Ah (100 WHr) cylindrical battery, HP BB09 Ultra-Capacity Extended Life
Battery (does not support HP Fast Charge)

 HP Fast Charge Technology

Security Integrated fingerprint reader

Integrated Smart Card reader

Preboot authentication (password, Smart Card)

Supports security lock

Trusted platform module (TPM) v.1.2 and TPM enhanced drive lock

Full volume encryption

Operating system Preinstalled operating systems:

● Windows® 7 Home Premium 64 (select models only)

● Windows 7 Professional 64 (select models only)

● Windows 7 Professional 32 (select models only)

● FreeDOS

 Operating system and Microsoft® Office preinstalled (not supported in Japan):

● Windows 7 Professional 64 with Office 2010 Starter (select models only)

● Windows 7 Professional 32 with Office 2010 Starter (select models only)

 Restore media:

● Windows 7 Professional 64 (select models only)

● Windows 7 Professional 32 (select models only)

● Windows 7 Home Premium 64 (select models only)

● Windows 7 DRDVD (select models only)

● Windows XP Professional 64 (service only)

 Certified:

● Microsoft WHQL

● Novell

● SuSE Linux
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Category Description

 Web-only support:

● Windows XP Professional 64 (select models only)

● Windows XP Professional 32 (select models only)

● Windows 7 Ultimate 64 (select models only)

● Windows 7 Ultimate 32 (select models only)

● Windows 7 Enterprise 64 (select models only)

● Windows 7 Enterprise 32 (select models only)

Serviceability End-user replaceable parts:

● Memory module

● Optical drive

● SIM

● WLAN module

● WWAN module
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Display — Windows models

Component Description

(1) Internal display switch Turns off the display or initiates Sleep if the display is closed
while the power is on.

NOTE: The display switch is not visible from the outside of the
computer.

(2) WLAN antennas (3)* Send and receive wireless signals to communicate with wireless
local area networks (WLAN).

(3) WWAN antennas (2)* (select models only) Send and receive wireless signals to communicate with wireless
wide area networks (WWAN).

(4) Internal microphones (2) Record sound.

(5) Webcam light On: The webcam is in use.

(6) Webcam Records video and captures still photographs.

To use the webcam on Windows 7 models, , select Start > All
Programs > Communication and Chat > HP Webcam.

For information about using the webcam in Windows 8, access
Help and Support. From the Start screen, type help, and then
select Help and Support.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately
around the antennas free from obstructions. To see wireless regulatory notices, see the section of the Regulatory, Safety,
and Environmental Notices that applies to your country or region. These notices are located in Help and Support. To access
this guide in Windows 8, select the HP Support Assistant app on the Start screen, select My computer, and then select
the User guides.
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Display — SUSE Linux models

Component Description

(1) Internal display switch Turns off the display or initiates Suspend if the display is closed
while the power is on.

NOTE: The display switch is not visible from the outside of the
computer.

(2) WLAN antennas (3)* Send and receive wireless signals to communicate with wireless
local area networks (WLAN).

(3) Internal microphones (2) Record sound.

(4) Webcam light On: The webcam is in use.

(5) Webcam Records video and captures still photographs.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately
around the antennas free from obstructions. To see wireless regulatory notices, see the section of the Regulatory, Safety,
and Environmental Notices that applies to your country or region. These notices are located in Help.
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TouchPad

Component Description

(1)  Left pointing stick button Can be used with the pointing stick and functions like the
left button on an external mouse.

(2)  Center pointing stick button Can be used with the pointing stick and functions like the
center button on an external mouse.

(3)  Pointing stick Moves the pointer and selects or activates items on the
screen.

(4)  Right pointing stick button Can be used with the pointing stick and functions like the
right button on an external mouse.

(5)  Right TouchPad button Functions like the right button on an external mouse.

(6)  Center TouchPad button Functions like the center button on an external mouse.

(7)  Left TouchPad button Functions like the left button on an external mouse.

(8)  TouchPad Moves the pointer and selects or activates items on the
screen.

(9)  TouchPad on/off button Turns the TouchPad on and off.
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Lights

Component Description

(1)  TouchPad on/off light ● Off: The TouchPad is on.

● Amber: The TouchPad is off.

(2)  Caps lock light On: Caps lock is on.

(3) Power light ● On: The computer is on.

● Blinking: The computer is in the Sleep state.

● Off: The computer is off or in Hibernation.

(4)  Num lock light On: Num lock is on.

(5) Wireless light ● White: An integrated wireless device, such as a
wireless local area network (WLAN) device and/or a
Bluetooth® device, is on.

● Amber: All wireless devices are off.

(6) Mute light ● Amber: Computer sound is off.

● White: Computer sound is on.

(7) Web browser light ● On: The computer is on.

● In Windows: Off: The computer is off or in Hibernation.

● In SUSE Linux: Off: The computer is off, in the
Suspend state, or in Hibernation.

(8) Calculator light ● On: The Windows® calculator function is on.

● Blinking: The calculator has been activated.
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Buttons and fingerprint reader (select models only)

Component Description

(1)  TouchPad on/off button Turns the TouchPad on and off.

(2) Power button ● When the computer is off, press the button to turn on
the computer.

● When the computer is on, press the button briefly to
initiate Sleep/Suspend.

● When the computer is in the Sleep/Suspend state,
press the button briefly to exit Sleep/Suspend.

● When the computer is in Hibernation, press the button
briefly to exit Hibernation.

If the computer has stopped responding and Windows
shutdown procedures are ineffective, press and hold the
power button for at least 5 seconds to turn off the computer.

To learn more about your power settings:

● Windows 7—Select Start > Control Panel > System
and Security > Power Options.

● Or refer to the HP Notebook Reference Guide.

● Windows 8—From the Start screen, type power
options. Click Settings, and then select Power
Options from the options displayed.

● SUSE Linux —

1. Select Computer > Control Center.

2. In the left pane, click System, and then click Power
Managementin the right pane.

(3) Wireless button Turns the wireless feature on or off but does not establish a
wireless connection.

(4) Volume mute button Mutes and restores speaker sound.
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Component Description

(5) Web browser button When Windows is running, press the button to open the
default Web browser.

(6) Calculator button Opens the Windows calculator function.

(7)  Fingerprint reader Allows a fingerprint logon to Windows, instead of a
password logon.

Top 13



Keys — Windows systems

Component Description

(1)  esc key Displays system information when pressed in coMBination
with the fn key.

(2)  Function keys Execute frequently used system functions when pressed in
combination with the fn key.

(3)  fn key Executes frequently used system functions when pressed
in combination with a function key or the esc key.

(4) Windows 7 button Displays the Windows Start menu.

 Windows 8 button  

(5) Windows 7 applications key Windows 7: Displays a shortcut menu for items beneath
the cursor.

 Windows 8 applications key Windows 8: Displays the App bar and a shortcut menu for
items beneath the cursor.

(6)  Integrated numeric keypad When the keypad has been enabled, the keys can be used
like an external numeric keypad.

(7)  num lk key Enables/disables the integrated numeric keypad when
pressed.
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Keys — SUSE Linux models

Component Description

(1)  Function keys Execute frequently used system functions when pressed in
combination with the fn key.

(2)  fn key Executes frequently used system functions when pressed in
combination with a function key.

(3)  Integrated numeric keypad When num lk has been enabled, it can be used like an
external numeric keypad. To alternate between this numeric
function and the navigational function (indicated by the
directional arrows on the keys), press the num lk key.

(4)  num lk key Alternates between the navigational and numeric functions
on the integrated numeric keypad.

Front
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Component Description

(1) Media Card reader Supports the following digital card formats:

● Secure Digital (SD) Card

● Secure Digital HC (SDHC) Card

● Secure Digital XC (SDXC) Card

● MultiMediaCard (MMC)

● MultiMediaCardplus (MMC+)

(2) Display release latch Opens the computer.

(3) Wireless light ● White: An integrated wireless device, such as a wireless
local area network (WLAN) device and/or a Bluetooth®
device, is on.

● Amber: All wireless devices are off.

(4) Power light ● On: The computer is on.

● Blinking: The computer is in the Sleep state.

● Off: The computer is off or in Hibernation.

(5) AC adapter/Battery light ● Amber: The computer is connected to external power and
the battery is charged from 0 – 90%.

● White: The computer is connected to external power and
the battery is charged from 90 – 99%.

● Blinking Amber: A battery that is the only available power
source has reached a low battery level. When the battery
reaches a critical battery level, the battery light begins
blinking rapidly.

● Off: The battery is fully charged.

(6) Hard drive light ● Blinking white: The hard drive is being accessed.

● Amber: HP 3D DriveGuard has temporarily parked the hard
drive.

NOTE: For information on HP 3D DriveGuard, see the
HP Notebook Reference Guide.

(7) Speakers (2) Produce sound.

NOTE: To use the SRS Premium Sound software in Windows
7, select Start > All Programs > SRS Premium Sound.

To use the SRS Premium Sound software n Windows 8, from the
Start screen, type SRS, and then select SRS Premium Sound.
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Right

Component Description

(1) Audio-out (headphone) jack Produces sound when connected to optional powered
stereo speakers, headphones, ear buds, a headset, or
television audio.

WARNING! To reduce the risk of personal injury, adjust
the volume before putting on headphones, earbuds, or a
headset. For additional safety information, refer to the
Regulatory, Safety and Environmental Notices. To access
this guide in Windows 8, select the HP Support Assistant
app on the Start screen, select My computer, and then
select the User guides.

NOTE: When a device is connected to the headphone
jack, the computer speakers are disabled.

(2) Audio in (microphone) jack Connects an optional computer headset microphone,
stereo array microphone, or monaural microphone.

(3) USB charging port Connects an optional USB device. The USB 2.0 charging
port can also charge select models of cell phones and MP3
players, even when the computer is off. For more
information about USB devices, see the HP Notebook
Reference Guide.

(4) USB 2.0 port Connects optional USB devices.

(5) External monitor port Connects an external VGA monitor or projector.

(6)  Smart Card reader Supports optional Smart Cards.

(7)  Upgrade bay (optical drive shown) The upgrade bay can hold a weight-saver option, a hard
drive, or an optical drive that reads an optical disc.

NOTE: On select models, the optical drive also writes to
an optical disc.

(8)  Optical drive eject button Releases the disc tray.
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Left

Component Description

(1) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from being
mishandled or stolen.

(2) USB 3.0 ports (2) Connect optional USB 3.0 devices and provide enhanced
USB power performance.

(3) 1394 port Connects an optional IEEE 1394 or 1394a device, such as
a camcorder.

(4)  Vents (2) Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(5) RJ-45 (network) jack Connects a network cable.

(6) DisplayPort Connects an optional digital display device, such as a high-
performance monitor or projector.

(7) eSATA/USB 2.0 combo port Connects a high-performance eSATA component, such as
an eSATA external hard drive, or connects an optional USB
device.

(8) ExpressCard slot Supports optional ExpressCards.
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Rear 

Component Description

(1) RJ-11 (modem) jack Connects a modem cable.

(2)  Vents (2) Enable airflow to cool internal components.

NOTE: The computer fan starts up
automatically to cool internal components and
prevent overheating. It is normal for the internal
fan to cycle on and off during routine operation.

(3) Power connector Connects an AC adapter.
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Bottom

Component Description

(1)  Battery bay Holds the battery.

(2) SIM slot Supports a wireless subscriber identity module (SIM).
The SIM slot is located inside the battery bay.

(3) Battery release latch Releases the battery.

(4)  Accessory battery connector Connects an optional accessory battery.

(5)  Docking connector Connects an optional docking device.

(6) Service door release latch Releases the service door from the computer.

(7)  Vents (3) Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to
cool internal components and prevent overheating. It is
normal for the internal fan to cycle on and off during
routine operation.

(8) Bluetooth compartment Contains a Bluetooth device (select models only).
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Component Description

(9)  Speakers (2) Produce sound.

NOTE: To use the SRS Premium Sound software,
select Start > All Programs > SRS Premium Sound.

(10) Service door Provides access to the hard drive bay, the wireless
LAN (WLAN) module slot, the WWAN module slot, and
the memory module slots.

NOTE: To prevent an unresponsive system, replace
the wireless module only with a wireless module
authorized for use in the computer by the
governmental agency that regulates wireless devices
in your country or region. If you replace the module
and then receive a warning message, remove the
module to restore computer functionality, and then
contact technical support through Help and Support.
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Item Description Spare part number

(1) Display

 Display panel, 43.9 cm (17.3 in), High Definition Plus (HD+) Anti-Glare (AG) WVA 691223-001

 Display panel, 43.9 cm (17.3 in), FHD AG LED WVA 691224-001

 Display assembly, 43.9 cm (17.3 in), FHD AG RGB LED UVWA Dream Color with webcam
(not available with HP Mobile Broadband) (includes display panel cable, 3 WLAN antenna
and cables, and 2 WWAN antenna and cables)

688736-001

 Display assembly, 43.9 cm (17.3 in), FHD AG RGB LED UVWA Dream Color without
webcam (not available with HP Mobile Broadband) (includes display panel cable, 3 WLAN
antenna and cables, and 2 WWAN antenna and cables)

688735-001

 NOTE: See Display components on page 29 for more display component information and spare part numbers.

(2) Keyboard (includes keyboard cable, pointing stick and pointing stick cable):

 Without backlight, for use in Belgium 688737-A41

 With backlight, for use in Belgium 688738–A41

 Without backlight, for use in Brazil 688737-201

 Without backlight, for use in Canada 688737-DB1

 With backlight for use in Canada 688738–DB1

 Without backlight, for use in Bulgaria 688737-261

 Without backlight, for use in Taiwan 688737-AB1

 With backlight, for use in Taiwan 688738-AB1

 Without backlight, for use in Denmark 688737-081

 With backlight, for use in Denmark 688738-081

 Without backlight, for use in Finland and Sweden 688737-B71

 With backlight, for use in Finland and Sweden 688738-B71

 Without backlight, for use in France 688737-051

 With backlight, for use in France 688738-051

 Without backlight, for use in Romania 688737–271

 Without backlight, for use in Germany 688737-041

 With backlight, for use in Germany 688738-041

 Without backlight, for use in Czechoslovakia 688737–FL1

 With backlight, for use in Czechoslovakia 688738–FL1

 Without backlight, for use in Hungary 688737-211

 Without backlight, for use in Iceland 688737-DD1

 Without backlight, for use in Israel 688737-BB1

 Without backlight, for use in Italy 688737-061

 With backlight, for use in Italy 688738-061

 Without backlight, for use in Japan 688737-291
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Item Description Spare part number

 Without backlight, for use in Latin America 688737-161

 With backlight, for use in Latin America 688738-161

 Without backlight, for international use 688737-B31

 With backlight, for international use 688738-B31

 Without backlight, for use in Northwest Africa 688737-FP1

 Without backlight, for use in Norway 688737-091

 With backlight, for use in Norway 688738-091

 Without backlight, for use in Portugal 688737-131

 Without backlight, for use in Russia 688737-251

 With backlight, for use in Russia 688738-251

 Without backlight, for use in Saudi Arabia 688737-171

 Without backlight, for use in Slovenia 688737-BA1

 Without backlight, for use in South Korea 688737-AD1

 With backlight, for use in South Korea 688738-AD1

 Without backlight, for use in Spain 688737-071

 Without backlight, for use in Switzerland 688737-BG1

 With backlight, for use in Switzerland 688738-BG1

 Without backlight, for use in Greece 688737–151

 Without backlight, for use in Thailand 688737-281

 With backlight, for use in Thailand 688738-281

 Without backlight, for use in Turkey 688737-141

 Without backlight, for use in the United Kingdom and Singapore 688737-031

 With backlight, for use in the United Kingdom and Singapore 688738-031

 Without backlight, for use in the United States 688737-001

 With backlight, for use in the United States 688738-001

 Without backlight (Windows 8) for use in the United States 701977–001

 With backlight (Windows 8) for use in the United States 701978–001

 With backlight (Windows 8) for use in The United Kingdom and Singapore 701978-031

 With backlight (Windows 8) for use in Germany 701978-041

 With backlight (Windows 8) for use in France 701978-051

 With backlight (Windows 8) for use in Italy 701978-061

 With backlight (Windows 8) for use in Denmark 701978-081

 With backlight (Windows 8) for use in Norway 701978-091

 With backlight (Windows 8) for use in Latin America 701978–161
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Item Description Spare part number

 With backlight (Windows 8) for use in Russia 701978-251

 With backlight (Windows 8) for use in Thailand 701978-281

 With backlight (Windows 8) for use in Belgium 701978-A41

 With backlight (Windows 8) for use in Taiwan 701978-AB1

 With backlight (Windows 8) for use in South Korea 701978-AD1

 With backlight (Windows 8) for use internationally 701978-B31

 With backlight (Windows 8) for use in Sweden and Finland 701978-B71

 With backlight (Windows 8) for use in Switzerland 701978-BG1

 With backlight (Windows 8) for use in India 701978-D61

 With backlight (Windows 8) for use in Canada 701978-DB1

 With backlight (Windows 8) for use in Czechoslovakia 701978-FL1

 Without backlight for use in India 688737-D61

 With backlight for use in India 688738-D61

 Without backlight, with pointing stick (Windows 8) for use in The United Kingdom and
Singapore

701977-031

 Without backlight, with pointing stick (Windows 8) for use in Germany 701977-041

 Without backlight, with pointing stick (Windows 8) for use in France 701977-051

 Without backlight, with pointing stick (Windows 8) for use in Italy 701977-061

 Without backlight, with pointing stick (Windows 8) for use in Spain 701977-071

 Without backlight, with pointing stick (Windows 8) for use in Denmark 701977-081

 Without backlight, with pointing stick (Windows 8) for use in Norway 701977-091

 Without backlight, with pointing stick (Windows 8) for use in Portugal 701977-131

 Without backlight, with pointing stick (Windows 8) for use in Turkey 701977-141

 Without backlight, with pointing stick (Windows 8) for use in Greece 701977-151

 Without backlight, with pointing stick (Windows 8) for use in Latin America 701977-161

 Without backlight, with pointing stick (Windows 8) for use in Saudi Arabia 701977-171

 Without backlight, with pointing stick (Windows 8) for use in Brazil 701977-201

 Without backlight, with pointing stick (Windows 8) for use in Hungary 701977-211

 Without backlight, with pointing stick (Windows 8) for use in Russia 701977-251

 Without backlight, with pointing stick (Windows 8) for use in Bulgaria 701977–261

 Without backlight, with pointing stick (Windows 8) for use in Romania 701977-271

 Without backlight, with pointing stick (Windows 8) for use in Thailand 701977-281

 Without backlight, with pointing stick (Windows 8) for use in Japan 701977-291

 Without backlight, with pointing stick (Windows 8) for use in Belgium 701977-A41

 Without backlight, with pointing stick (Windows 8) for use in Taiwan 701977-AB1
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Item Description Spare part number

 Without backlight, with pointing stick (Windows 8) for use in South Korea 701977-AD1

 Without backlight, with pointing stick (Windows 8) for use in Internationally 701977-B31

 Without backlight, with pointing stick (Windows 8) for use in Sweden and Finland 701977-B71

 Without backlight, with pointing stick (Windows 8) for use in Slovenia 701977-BA1

 Without backlight, with pointing stick (Windows 8) for use in Israel 701977-BB1

 Without backlight, with pointing stick (Windows 8) for use in Switzerland 701977-BG1

 Without backlight, with pointing stick (Windows 8) for use in India 701977-D61

 Without backlight, with pointing stick (Windows 8) for use in Canada 701977-DB1

 Without backlight, with pointing stick (Windows 8) for use in Iceland 701977-DD1

 Without backlight, with pointing stick (Windows 8) for use in Czechoslovakia 701977-FL1

 Without backlight, with pointing stick (Windows 8) for use in Northwest Africa 701977–FP1

 Without backlight, with pointing stick (Windows 8) for use in Romania 701977-261

(3) Top cover (includes TouchPad) 688747-001

(4) TouchPad (included with top cover)  

(5) RTC battery 651948-001

(6) Fan/graphics board heat sink assembly (includes replacement thermal material):  

 For use with AMD graphics subsystem 688733-001

 For use with NVIDIA graphics subsystem 696435-001

(7) Primary memory modules (PC3-10600, 1333 MHz, shared):  

 2 GB — 2048 MB memory module (PC3-12800, 1600 MHz, DDR3) 652792-001

 4 GB — 4096 MB memory module (PC3-12800, 1600 MHz, DDR3) 641369-001

 8 GB — 8192 MB memory module (PC3-12800, 1600 MHz, DDR3) 670034-001

(8) Fan/heat sink assembly (includes replacement thermal material): 653629-001

688762-001

(9) Processor (includes replacement thermal material):  

 Next Generation Intel® Core™ processors (support Intel Turbo Boost Technology):

 i7-3520M, 2.90 GHz (Turbo up to 3.60 GHz), 1600 MHz, 4 MB L3 Cache, 4 threads, 35W 681954-001

 i7-3610QM, 2.30 GHz (Turbo up to 3.30 GHz), 1600 MHz, 6 MB L3 Cache, 8 threads, 45W 680646-001

 i7-3720QM, 2.60 GHz (Turbo up to 3.60 GHz), 1600 MHz, 6 MB L3 Cache, 8 threads, 45W 681283-001

 i7-3820QM, 2.70 GHz (Turbo up to 3.70 GHz), 1600 MHz, 8 MB L3 Cache, 8 threads, 45W 681284-001

 i7-3920XM, 2.90 GHz (Turbo up to 3.80 GHz), 1600 MHz, 8 MB L3 Cache, 8 threads,
55W55W

691351-001

 Next Generation Intel® Core™ i5 processors (support Intel Turbo Boost Technology):  

 i5-3320M, 2.60 GHz (Turbo up to 3.30 GHz), 1600 MHz, 3 MB L3 Cache, 4 threads, 35W 681952-001

 i5-3360M, 2.80 GHz (Turbo up to 3.50 GHz), 1600 MHz, 3 MB L3 Cache, 4 threads, 35W 681953-001
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Item Description Spare part number

(10) Graphics board (includes replacement thermal material):

 AMD FirePro M5950 XT-GL 1GB GDDR5 (DP 1.2 and Eyefinity Plus support) 689279-001

 NVIDIA Quadro 3000M, N14E-Q1 2 GB dedicated GDDR5 video memory 689280-001

 NVIDIA Quadro 4000M, N14E-Q3 2 GB dedicated GDDR5 video memory 689281-001

 NVIDIA Quadro 5010M, N14E-Q5 4 GB dedicated GDDR5 video memory 689282-001

(11) Processor heat sink  

 For use only with computer models equipped with dual-core processors 652542-001

 For use only with computer models equipped with quad-core processors 653629-001

(12) Modem module 56K V.92 data/fax modem

NOTE: The modem module spare part kit does not include a modem module cable. The
modem module cable is included in the Cable Kit, spare part number 652545-001.

628824-001

(13) System board (includes replacement thermal material)

 For use in all countries and regions except the People's Republic of China:

 ● For use with computer models equipped with Intel quad-core processors 688746-001

 ● For use with computer models equipped with Intel dual-core processors 688745-001

 For use only in the People's Republic of China:

 ● For use with computer models equipped with Intel quad-core processors 690035-001

 ● For use with computer models equipped with Intel dual-core processors 690034-001

(14) Expansion memory modules (PC3-10600, 1333 MHz, shared):  

 2 GB — 2048 MB memory module (PC3-12800, 1600 MHz, DDR3) 652972-001

 4 GB — 4096 MB memory module (PC3-12800, 1600 MHz, DDR3) 641369-001

 8 GB— 8192 MB memory module (PC3-12800, 1600 MHz, DDR3) 670034-001

(15) Solid-state drive (includes bracket and screws)  

 ● 256 GB solid-state drive Self-Encrypting drive (SED) 688767-001

 ● 128 GB solid-state drive 688766-001

 ● 160 GB solid-state drive 688768-001

 ● 180 GB solid-state drive 700373-001

(16) WLAN module:

 Intel® Centrino™ Advanced-N 6205, 802.11a/b/g/n WLAN module 695915-001

 Intel Centrino Ultimate-N 6300, 802.11a/b/g/n WLAN module 698588-001

 Broadcom 802.11a/b/g/n 2x2WiFi Adapter 669832-001

(17) WWAN module:

 HP un2430 EV-DO/HSPA Mobile Broadband Module 634400-001

 HP hs2340 HSPA+ Mobile Broadband Module 668969-001

(18) Speaker assembly 652540-001
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Item Description Spare part number

(19) Audio/USB 2.0 board 689284-001

(20) Display (VGA) port 696435-001

(21) Power connector cable

NOTE: The power connector cable is included in the Cable Kit, spare part number 652545-001.

(22) Modem cable 628824-001

(23) Network cable (includes RJ-45 jack)

NOTE: The network cable is included in the Cable Kit, spare part number 652545-001.

652545-001

(24) USB 3.0 board 689283-001

(25) Battery:  

 9-cell, Li-ion, 2.2 Ah (73 WHr) 634089-001

 9-cell, Li-ion, 3.0 Ah (100 WHr) 634087–001

 8-cell, Li-ion, 2.8 Ah (75 WHr) 632425-001

 8-cell, Li-ion, 2.8 Ah (83 WHr) 632427-001

(26) Base enclosure (includes computer feet) 688765-001

(27) ExpressCard (plastic insert) 655546-001

(28) Mass storage device

 Supports 7.0 mm (0.28 in), 9.5 mm (0.37 in) or 12.7 mm (0.5 in) hard drives and 6.35 cm (2.5 in) solid-state drive for
primary and secondary storage:

NOTE: The hard drive bracket and screws are included in the Hard Drive Hardware Kit, spare part number
642774-001.

 ● 750 GB, SATA, 7200-rpm 633252-001

 ● 500 GB, SATA, 7200-rpm 634925-001

 ● 320 GB, SATA, 7200-rpm 634862-001

 ● 500 GB SATA SED (Self-Encrypting Drive), 7200-rpm 683801-001

(29) Optical drive (includes bezel and bracket) supported in upgrade bay

 Blu-ray R/RE DVD±RW SuperMulti Double-Layer Drive 688772-001

 Blu-ray ROM DVD±RW SuperMulti Double-Layer Drive 688771-001

 DVD±RW SuperMulti Double-Layer Drive 688770-001

 DVD-ROM Drive 688769-001

 Also supported in upgrade bay:  

 500 GB, 7200 rpm hard drive 634925-001

(30) Service access cover 698410-001

699467-001 (RCTO)

(31) Smart Card reader (includes cable) 688742-001
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Display components

Item Description Spare part number

(1) Display bezel

 Display bezel 688763-001

(2) Webcam module 688752-001

(3) Display  

 Display panel, 43.9 cm (17.3 in), FHD AG WVA 691224-001

 Display panel, 43.9 cm (17.3 in), HD+ AG WVA 691223-001
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Item Description Spare part number

 Display assembly, 43.9 cm (17.3 in), FHD AG RGB LED UVWA Dream Color with
webcam (not available with HP Mobile Broadband) (includes display panel cable, 3 WLAN
antenna and cables, and 2 WWAN antenna and cables)

688736–001

 Display assembly, 43.9 cm (17.3 in), FHD AG RGB LED UVWA Dream Color without
webcam (not available with HP Mobile Broadband) (includes display panel cable, 3 WLAN
antenna and cables, and 2 WWAN antenna and cables)

688735-001

(4) Display hinge cover 652529-001

(5) Display Hinge Brackets (included in Display Hinge Kit, left and right hinges and brackets) 652528-001

(6) WWAN antenna and cables (included in the Antenna Kit, spare part number 652530-001)

(7) WLAN antenna and cables (included in the Antenna Kit, spare part number 652530-001)

(8) Display panel cable (includes webcam module cable) 688761-001

(9) Webcam cable 652527-001

(10) Display enclosure 652524-001

(11) Hinge Pipe (included in Display Hinge Kit) 652528-001

 Antenna Kit (includes WLAN and WWAN antennas) (not illustrated) 652530-001

 Microphone (not illustrated) 655312-001

 CRT board (not illustrated) 688741-001
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Mass storage devices

Item Description Spare part number

(1) 7.0 mm (0.28 in), 9.5 mm (0.37 in), or 12.7 mm (0.5 in) hard drive:

NOTE: The hard drive bracket is included in the Hard Drive Hardware Kit, spare part number 642774-001.

 ● 750 GB, 7200-rpm 633252-001

 ● 500 GB, 7200-rpm 634925-001

 ● 320 GB, 7200-rpm 634862-001

 ● 320 GB, 7200-rpm SATA SED (Self-Encrypting Drive) 683801-001

(2) Hard drive bracket (Included only with solid-state drives. See spare part numbers below
in this table.)

 

(3) Optical drive bracket (Included with optical drive. See spare part numbers below in this
table.)

688769-001

(4) Optical drive (includes bezel and bracket)  

 Blu-ray R/RE DVD±RW SuperMulti Double-Layer Drive 688772-001

 DVD±RW SuperMulti Double-Layer Drive 688771-001

 Blu-ray ROM DVD±RW SuperMulti Double-Layer Drive 688770-001
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Item Description Spare part number

 DVD-ROM Drive 688769-001

(5) 6.35 cm (2.50 in) Solid-state drive (includes bracket):  

 ● 256 GB solid-state drive Self-Encrypting drive (SED) 688767-001

 ● 128 GB solid-state drive

● 688766-001

 

 ● 160 GB solid-state drive 688768-001

 ● 180 GB solid-state drive 700373-001

● 2
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701479–001
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Miscellaneous parts
Description Spare part number

AC Adapter

200W PFC Slim AC Smart Adapter 693708-001

230W PFC AC Smart Adapter 693714-001

Power cord (3 conductor, black,1.83 m):

For use in Argentina 491683-D01

For use in Australia 491683-011

For use in Brazil 491683-202

For use in Denmark 491683-081

For use in Europe, the Middle East, and Africa 491683-021

For use in India 491683-D61

For use in Israel 491683-BB1

For use in Saudi Arabia 491683-171

For use in Japan 491683-291

For use in North America 491683-001

For use in the People's Republic of China 491683-AA1

For use in South Africa 491683-AR1

For use in South Korea 491683-AD1

For use in Switzerland 491683-111

For use in Taiwan 491683-AB1

For use in Thailand 491683-201

For use in the United Kingdom and Singapore 491683-031

Hard Drive Hardware Kit (includes hard drive bracket and screws) 642774-001

Hard drive upgrade bay 655547-001

Screw Kit 688744-001

ExpressCard socket 652547-001
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Sequential part number listing
CSR flag designations:

A = Mandatory

B = Optional

C = Service technician recommended

N = Non-user replaceable

Spare part
number

CSR flag Description

434594-001 A Optical USB travel mouse

491683-001 A Power cord for use in North America (3 conductor, black,1.83 m)

491683-011 A Power cord for use in Australia (3 conductor, black,1.83 m)

491683-021 A Power cord for use in Europe, the Middle East, and Africa (3 conductor, black,1.83 m)

491683-031 A Power cord for use in Singapore and the United Kingdom (3 conductor, black,1.83 m)

491683-081 A Power cord for use in Denmark (3 conductor, black,1.83 m)

491683-111 A Power cord for use in Switzerland (3 conductor, black,1.83 m)

491683-171 A Power cord for use in Saudi Arabia (3 conductor, black,1.83 m)

491683-201 A Power cord for use in Thailand (3 conductor, black,1.83 m)

491683-202 A Power cord for use in Brazil (3 conductor, black,1.83 m)

491683-291 A Power cord for use in Japan (3 conductor, black,1.83 m)

491683-AA1 A Power cord for use in the People's Republic of China (3 conductor, black,1.83 m)

491683-AB1 A Power cord for use in Taiwan (3 conductor, black,1.83 m)

491683-AD1 A Power cord for use in South Korea (3 conductor, black,1.83 m)

491683-AR1 A Power cord for use in South Africa (3 conductor, black,1.83 m)

491683-BB1 A Power cord for use in Israel (3 conductor, black,1.83 m)

491683-D01 A Power cord for use in Argentina (3 conductor, black,1.83 m)

491683-D61 A Power cord for use in India (3 conductor, black,1.83 m)

591699-001 A Notebook combination lock

592923–001 A Professional Slim Top Load notebook case

626729-002 A Keyed cable lock

628824-001 A Modem, 56K V.92 data/fax modem

632425-001 A Battery, 8-cell, Li-ion, 2.8 Ah (75 WHr)

632427-001 A Battery, 8-cell, Li-ion, 2.8 Ah (83 WHr)

633252-001 A Hard drive, 750GB 7200–RPM SATA

Hard drive, 750 GB, 7200-rpm SATA

634087-001 A Battery, 9-cell, Li-ion, 3.0 Ah (100 WHr)
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Spare part
number

CSR flag Description

634089-001 A Battery, 9-cell, Li-ion, 2.2 Ah (73 WHr)

634400-001 A WWAN, HP un2430 EV-DO/HSPA Mobile Broadband Module

634862-001 A Hard drive, 320 GB, 7200-rpm SATA 

634925-001 A Hard drive, 500GB, 7200-rpm SATA 

641369-001 A Memory module, 4GB (PC3-12800, 1600 MHz)

642774-001 A Hard Drive Hardware Kit (includes hard drive bracket and screws)

651948-001 N RTC battery

652524-001 N Display enclosure

652527-001 N Webcam cable

652528-001 N Display Hinge Kit (includes left and right hinges, hinge pipe, and brackets)

652529-001 N Display hinge covers

652530–001 N Antenna Kit (includes WLAN antenna and cables and WWAN antenna and cables)

652532-001 N Display Rubber Kit (includes 2 bezel rubber bumpers and 8 rubber screw covers)

652533-001 N Display Miscellaneous Kit

652540-001 N Speaker assembly

652542-001 N Processor heat sink for use only with computer models equipped with dual-core
processors (includes replacement thermal material)

652545-001 N Cable Kit (includes DC-jack cable, RJ-45 cable, modem module cable, Bluetooth cable)

652546-001 N Smart Card cover

652547-001 N ExpressCard socket 

652972-001 A Memory module, 2 GB (PC3-12800, 1600 MHz)

653629-001 N Processor heat sink for use only with computer models equipped with quad-core
processors (includes replacement thermal material)

655312-001 N Microphone

655546-001 N Plastics Kit (includes optical drive compartment cover, RJ-11 (modem) jack cover, SD
Card cover, and Express Card slot cover)

655547-001 N Upgrade bay hard drive

655792-001 A Bluetooth module, HP Integrated Module with Bluetooth 4.0+ ENH Data Rate Wireless
Technology

NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable.
The Bluetooth module cable is included in the Cable Kit, spare part number 652545-001.

656840-001 A Wireless mouse 2.4–GHZ 

658265-001 N Display Panel Support Kit (includes display enclosure, WLAN antenna cables, WWAN
antenna cables, and webcam cable)

660578-001 A Upgrade bay bezel 15/17W 

668969-001 A WWAN, HP hs2340 HSPA+ Mobile Broadband Module
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Spare part
number

CSR flag Description

669832-001 A Broadcom 802.11a/b/g/n 2x2WiFi Adapter

670034-001 A Memory module, 8 GB (PC3-12800, 1600 MHz)

674318–001 Laser USB travel mouse

680646-001 N Next Generation Intel® Core™ i7 Processor i7-3610QM, 2.30 GHz (Turbo up to 3.30
GHz), 1600 MHz, 6 MB L3 Cache, 8 threads, 45W 

681283-001 N Next Generation Intel® Core™ i7 Processor, i7–3720QM, 2.60 GHz (Turbo up to 3.60
GHz), 1600 MHz, 6 MB L3 Cache, 8 threads, 45W

681284-001 N Next Generation Intel® Core™ i7 Processor, i7-3820QM, 2.70 GHz (Turbo up to 3.70
GHz), 1600 MHz, 8 MB L3 Cache, 8 threads, 45W 

681952-001 N Next Generation Intel® Core™ i5 Processor, i5–3320M, 2.60 GHz (Turbo up to 3.30
GHz), 1600 MHz, 3 MB L3 Cache, 4 threads, 35W

681953-001 N Next Generation Intel® Core™ i5 Processor, 5–3360M, 2.80 GHz (Turbo up to 3.50
GHz), 1600 MHz, 3 MB L3 Cache, 4 threads, 35W 

681954-001 N Next Generation Intel® Core™ i7 Processor, i7-3520M, 2.90 GHz (Turbo up to 3.60
GHz), 1600 MHz, 4 MB L3 Cache, 4 threads, 35W 

683801-001 A Hard drive, 500 GB, 7200-rpm SATA SED (Self-Encrypting Drive)

688169-001 A Docking station/Expansion base

688733-001 N Fan/graphics board heat sink assembly for use only with computer models equipped with
AMD graphics subsystems (includes replacement thermal material)

688735-001 N Display assembly, 43.9 cm (17.3 in), FHD AG RGB LED UVWA Dream Color without
webcam (not available with HP Mobile Broadband) (includes display panel cable, 3
WLAN antenna and cables, and 2 WWAN antenna and cables)

688736-001 N Display assembly, 43.9 cm (17.3 in), FHD AG RGB LED UVWA Dream Color with
webcam (not available with HP Mobile Broadband) (includes display panel cable, 3
WLAN antenna and cables, and 2 WWAN antenna and cables)

688737-001 A Keyboard without backlight for use in the United States (includes keyboard cable,
pointing stick and pointing stick cable)

688737-031 A Keyboard without backlight for use in Singapore and the United Kingdom (includes
keyboard cable, pointing stick and pointing stick cable)

688737-041 A Keyboard without backlight for use in Germany (includes keyboard cable, pointing stick
and pointing stick cable)

688737-051 A Keyboard without backlight for use in France (includes keyboard cable, pointing stick and
pointing stick cable)

688737-061 A Keyboard without backlight for use in Italy (includes keyboard cable, pointing stick and
pointing stick cable)

688737-071 A Keyboard without backlight for use in Spain (includes keyboard cable, pointing stick and
pointing stick cable)

688737-081 A Keyboard without backlight for use in Denmark (includes keyboard cable, pointing stick
and pointing stick cable)

688737-091 A Keyboard without backlight for use in Norway (includes keyboard cable, pointing stick and
pointing stick cable)

688737-131 A Keyboard without backlight for use in Portugal (includes keyboard cable, pointing stick
and pointing stick cable)
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Spare part
number

CSR flag Description

688737-141 A Keyboard without backlight for use in Turkey (includes keyboard cable, pointing stick and
pointing stick cable)

688737-151 A Keyboard without backlight for use in Greece (includes keyboard cable, pointing stick and
pointing stick cable)

688737-161 A Keyboard without backlight for use in Latin America (includes keyboard cable, pointing
stick and pointing stick cable)

688737-171 A Keyboard without backlight for use in Saudi Arabia (includes keyboard cable, pointing
stick and pointing stick cable)

688737-201 A Keyboard without backlight for use in Brazil (includes keyboard cable, pointing stick and
pointing stick cable)

688737-211 A Keyboard without backlight for use in Hungary (includes keyboard cable, pointing stick
and pointing stick cable)

688737-251 X2 Keyboard without backlight for use in Russia (includes keyboard cable, pointing stick and
pointing stick cable)

688737-261 A Keyboard without backlight for use in Bulgaria (includes keyboard cable, pointing stick
and pointing stick cable)

688737–271 A Keyboard without backlight for use in Romania (includes keyboard cable, pointing stick
and pointing stick cable)

688737-281 A Keyboard without backlight for use in Thailand (includes keyboard cable, pointing stick
and pointing stick cable)

688737-291 A Keyboard without backlight for use in Japan (includes keyboard cable, pointing stick and
pointing stick cable)

688737-A41 A Keyboard without backlight for use in Belgium (includes keyboard cable, pointing stick
and pointing stick cable)

688737-AB1 A Keyboard without backlight for use in the Czech Republic and Slovakia (includes
keyboard cable, pointing stick and pointing stick cable)

688737-AD1 A Keyboard without backlight for use in South Korea (includes keyboard cable, pointing
stick and pointing stick cable)

688737-B31 A Keyboard without backlight for international use (includes keyboard cable, pointing stick
and pointing stick cable)

688737-B71 A Keyboard without backlight for use in Finland and Sweden (includes keyboard cable,
pointing stick and pointing stick cable)

688737-BA1 A Keyboard without backlight for use in Slovenia (includes keyboard cable, pointing stick
and pointing stick cable)

688737-BB1 A Keyboard without backlight for use in Israel (includes keyboard cable, pointing stick and
pointing stick cable)

688737-BG1 A Keyboard without backlight for use in Switzerland (includes keyboard cable, pointing stick
and pointing stick cable)

688737-D61 A Keyboard without backlight for use in India (includes keyboard cable, pointing stick and
pointing stick cable)

688737–DB1 A Keyboard without backlight for use in Canada (includes keyboard cable, pointing stick
and pointing stick cable)

688737-DD1 A Keyboard without backlight for use in Iceland (includes keyboard cable, pointing stick and
pointing stick cable)
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688737-FL1 A Keyboard without backlight for use in Czechoslovakia (includes keyboard cable, pointing
stick and pointing stick cable)

688737-FP1 A Keyboard without backlight for use in Northwest Africa (includes keyboard cable, pointing
stick and pointing stick cable)

688738-001 A Keyboard with backlight for use in the United States (includes keyboard cable, pointing
stick and pointing stick cable)

688738-031 A Keyboard with backlight for use in the United Kingdom (includes keyboard cable, pointing
stick and pointing stick cable)

688738-041 A Keyboard with backlight for use in Germany (includes keyboard cable, pointing stick and
pointing stick cable)

688738-051 A Keyboard with backlight for use in France (includes keyboard cable, pointing stick and
pointing stick cable)

688738-061 A Keyboard with backlight for use in Italy (includes keyboard cable, pointing stick and
pointing stick cable)

688738-081 A Keyboard with backlight for use in Denmark (includes keyboard cable, pointing stick and
pointing stick cable)

688738-091 A Keyboard with backlight for use in Norway (includes keyboard cable, pointing stick and
pointing stick cable)

688738-161 A Keyboard with backlight for use in Latin America (includes keyboard cable, pointing stick
and pointing stick cable)

688738-251 A Keyboard with backlight for use in Russia (includes keyboard cable, pointing stick and
pointing stick cable)

688738-281 A Keyboard with backlight for use in Thailand (includes keyboard cable, pointing stick and
pointing stick cable)

688738-A41 A Keyboard with backlight for use in Belgium (includes keyboard cable, pointing stick and
pointing stick cable)

688738-AB1 A Keyboard with backlight for use in Taiwan (includes keyboard cable, pointing stick and
pointing stick cable)

688738-AD1 A Keyboard with backlight for use in South Korea (includes keyboard cable, pointing stick
and pointing stick cable)

688738-B31 A Keyboard with backlight for use in Europe (includes keyboard cable, pointing stick and
pointing stick cable)

688738-B71 A Keyboard with backlight for use in Finland and Sweden (includes keyboard cable,
pointing stick and pointing stick cable)

688738-BG1 X2 Keyboard with backlight for use in Switzerland (includes keyboard cable, pointing stick
and pointing stick cable)

688738-D61 A Keyboard with backlight for use in India (includes keyboard cable, pointing stick and
pointing stick cable)

688738-DB1 A Keyboard with backlight for use in Canada (includes keyboard cable, pointing stick and
pointing stick cable)

688738-FL1 A Keyboard with backlight for use in Czechoslovakia (includes keyboard cable, pointing
stick and pointing stick cable)

688741-001 N CRT board
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688742-001 A Smart Card (includes cable) 

688743-001 N Fingerprint reader (includes cable) 

688744-001 A Screw Kit

688745-001 N System board for use with computer models equipped with Intel quad-core processors in
all countries and regions except the People's Republic of China (includes replacement
thermal material)

688745–501 N System board for use with computer models equipped with Intel quad-core processors in
all countries and regions for Windows 8 standard except the People's Republic of China
(includes replacement thermal material)

688745–601 N System board for use with computer models equipped with Intel quad-core processors in
all countries and regions for Windows 8 professional except the People's Republic of
China (includes replacement thermal material)

688746-001 N System board for use with computer models equipped with Intel quad-core processors in
all countries and regions except the People's Republic of China (includes replacement
thermal material)

688746–501 N System board for use with computer models equipped with Intel quad-core processors for
Windows 8 standard in all countries and regions except the People's Republic of China
(includes replacement thermal material)

688746–601 N System board for use with computer models equipped with Intel quad-core processors for
Windows 8 professional in all countries and regions except the People's Republic of
China (includes replacement thermal material)

688747-001 C Top cover (includes TouchPad)

688749-001 N Power button board

688752-001 N Webcam module with microphone

688760-001 N Latch kit (includes door and battery latches) 

688761-001 N Display panel cable (includes webcam module cable)

688762-001 B Fan

688763–001 N Display bezel

688765-001 N Base enclosure (includes computer feet)

688766-001 N 128 GB solid-state drive (includes bracket)

688767-001 N 256 GB solid-state drive (includes bracket)

688768-001 N 160 GB solid-state drive (includes bracket)

688769-001 A DVD-ROM Drive

688770-001 A Optical drive, DVD±RW SuperMulti Double-Layer Drive

688771-001 A Optical drive, Blu-ray ROM DVD±RW SuperMulti Double-Layer Drive

688772-001 A Optical drive, Blu-ray R/RE DVD±RW SuperMulti Double-Layer Drive

689279-001 N Graphics board, AMD Firepro M2 XT GL 

689280-001 N Graphics board, NVIDIA Quadro 3000M, N14E-Q1 2 GB dedicated GDDR5 video
memory
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689281-001 N Graphics board, NVIDIA Quadro 4000M, N14E-Q3 2 GB dedicated GDDR5 video
memory

689282-001 N Graphics board, NVIDIA Quadro 5010M, N14E-Q5 4 GB dedicated GDDR5 video
memory

689283-001 N USB 3.0 board (includes cable)

689284-001 N Audio/USB 2.0 board

690034-001 N System board for use with computer models equipped with Intel quad-core processors in
the People's Republic of China (includes replacement thermal material) 

690035-001 N System board for use with computer models equipped with Intel quad-core processors in
the People's Republic of China (includes replacement thermal material)

691223-001 N Display panel, 43.9 cm (17.3 in), HD+ AG WVA

691224-001 N Display panel, 43.9 cm (17.3 in), FHD AG WVA

691351-001 N Next Generation Intel® Core i7-3920XM, 2.90 GHz (Turbo up to 3.80 GHz), 1600 MHz, 8
MB L3 Cache, 8 threads, 55W 

693708-001 A AC adapter, 200 W PFC Slim AC Smart adapter

693714-001 A AC adapter, 230 W PFC AC Smart adapter

695915–001 A Intel® Centrino™ Advanced-N 6205, 802.11a/b/g/n WLAN module

696435-001 N Fan/graphics board heat sink assembly, for use only with computer models equipped with
NVIDIA Quadro graphics subsystems (includes replacement thermal material)

696901-001 N Application board

698410-001 N Service access door

698588–001 A Intel Centrino Ultimate–N 6300 802.11a/b/g/n 3x3WiFi NMA Adapter

699467-001 A Service access door (RCTO)

700373-001 N 180 GB solid-state drive (includes bracket)

701479-001 N 24 GB solid-state drive (includes bracket)

701977–001 A Keyboard (Windows 8) without backlight for use in the United States (includes keyboard
cable, pointing stick and pointing stick cable)

701977-031 A Keyboard (Windows 8) without backlight for use in The United Kingdom and Singapore
(includes keyboard cable, pointing stick and pointing stick cable)

701977-041 A Keyboard (Windows 8) without backlight for use in Germany (includes keyboard cable,
pointing stick and pointing stick cable)

701977-051 A Keyboard (Windows 8) without backlight for use in France (includes keyboard cable,
pointing stick and pointing stick cable)

701977-061 A Keyboard (Windows 8) without backlight for use in Italy (includes keyboard cable,
pointing stick and pointing stick cable)

701977-071 A Keyboard (Windows 8) without backlight for use in Spain (includes keyboard cable,
pointing stick and pointing stick cable)

701977-081 A Keyboard (Windows 8) without backlight for use in Denmark (includes keyboard cable,
pointing stick and pointing stick cable)
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701977-091 A Keyboard (Windows 8) without backlight for use in Norway (includes keyboard cable,
pointing stick and pointing stick cable)

701977-131 A Keyboard (Windows 8) without backlight for use in Portugal (includes keyboard cable,
pointing stick and pointing stick cable)

701977-141 A Keyboard (Windows 8) without backlight for use in Turkey (includes keyboard cable,
pointing stick and pointing stick cable)

701977-151 A Keyboard (Windows 8) without backlight for use in Greece (includes keyboard cable,
pointing stick and pointing stick cable)

701977-161 A Keyboard (Windows 8) without backlight for use in Latin America (includes keyboard
cable, pointing stick and pointing stick cable)

701977-171 A Keyboard (Windows 8) without backlight for use in Saudi Arabia (includes keyboard
cable, pointing stick and pointing stick cable)

701977-201 A Keyboard (Windows 8) without backlight for use in Brazil (includes keyboard cable,
pointing stick and pointing stick cable)

701977-211 A Keyboard (Windows 8) without backlight for use in Hungary (includes keyboard cable,
pointing stick and pointing stick cable)

701977-251 A Keyboard (Windows 8) without backlight for use in Russia (includes keyboard cable,
pointing stick and pointing stick cable)

701977-261 A Keyboard (Windows 8) without backlight for use in Bulgaria (includes keyboard cable,
pointing stick and pointing stick cable)

701977-271 A Keyboard (Windows 8) without backlight for use in Romania (includes keyboard cable,
pointing stick and pointing stick cable)

701977-281 A Keyboard (Windows 8) without backlight for use in Thailand (includes keyboard cable,
pointing stick and pointing stick cable)

701977-291 A Keyboard (Windows 8) without backlight for use in Japan (includes keyboard cable,
pointing stick and pointing stick cable)

701977-A41 A Keyboard (Windows 8) without backlight for use in Belgium (includes keyboard cable,
pointing stick and pointing stick cable)

701977-AB1 A Keyboard (Windows 8) without backlight for use in Taiwan (includes keyboard cable,
pointing stick and pointing stick cable)

701977-AD1 A Keyboard (Windows 8) without backlight for use in South Korea (includes keyboard cable,
pointing stick and pointing stick cable)

701977-B31 A Keyboard (Windows 8) without backlight for use internationally (includes keyboard cable,
pointing stick and pointing stick cable)

701977-B71 A Keyboard (Windows 8) without backlight for use in Finland and Sweden (includes
keyboard cable, pointing stick and pointing stick cable)

701977-BA1 A Keyboard (Windows 8) without backlight for use in Slovenia (includes keyboard cable,
pointing stick and pointing stick cable)

701977-BB1 A Keyboard (Windows 8) without backlight for use in Israel (includes keyboard cable,
pointing stick and pointing stick cable)

701977-BG1 A Keyboard (Windows 8) without backlight for use in Switzerland (includes keyboard cable,
pointing stick and pointing stick cable)

701977-D61 A Keyboard (Windows 8) without backlight for use in India (includes keyboard cable,
pointing stick and pointing stick cable)
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701977-DB1 A Keyboard (Windows 8) without backlight for use in Canada (includes keyboard cable,
pointing stick and pointing stick cable)

701977-DD1 A Keyboard (Windows 8) without backlight for use in Iceland (includes keyboard cable,
pointing stick and pointing stick cable)

701977-FL1 A Keyboard (Windows 8) without backlight for use in Czechoslovakia (includes keyboard
cable, pointing stick and pointing stick cable)

701977-FP1 A Keyboard (Windows 8) without backlight for use in Northwest Africa (includes keyboard
cable, pointing stick and pointing stick cable)

701978-001 A Keyboard (Windows 8) with backlight for use in The United States (includes keyboard
cable, pointing stick and pointing stick cable)

701978-031 A Keyboard (Windows 8) with backlight for use in The United Kingdom and Singapore
(includes keyboard cable, pointing stick and pointing stick cable)

701978-041 A Keyboard (Windows 8) with backlight for use in Germany (includes keyboard cable,
pointing stick and pointing stick cable)

701978-051 A Keyboard (Windows 8) with backlight for use in France (includes keyboard cable, pointing
stick and pointing stick cable)

701978-061 A Keyboard (Windows 8) with backlight for use in Italy (includes keyboard cable, pointing
stick and pointing stick cable)

701978-081 A Keyboard (Windows 8) with backlight for use in Denmark (includes keyboard cable,
pointing stick and pointing stick cable)

701978-091 A Keyboard (Windows 8) with backlight for use in Denmark (includes keyboard cable,
pointing stick and pointing stick cable)

701978-161 A Keyboard (Windows 8) with backlight for use in Latin America (includes keyboard cable,
pointing stick and pointing stick cable)

701978-251 A Keyboard (Windows 8) with backlight for use in Russia (includes keyboard cable, pointing
stick and pointing stick cable)

701978-281 A Keyboard (Windows 8) with backlight for use in Thailand (includes keyboard cable,
pointing stick and pointing stick cable)

701978-A41 A Keyboard (Windows 8) with backlight for use in Belgium (includes keyboard cable,
pointing stick and pointing stick cable)

701978-AB1 A Keyboard (Windows 8) with backlight for use in Czech Republic and Slovakia (includes
keyboard cable, pointing stick and pointing stick cable)

701978-AD1 A Keyboard (Windows 8) with backlight for use in South Korea (includes keyboard cable,
pointing stick and pointing stick cable)

701978-B31 A Keyboard (Windows 8) with backlight for use in Internationally (includes keyboard cable,
pointing stick and pointing stick cable)

701978-B71 A Keyboard (Windows 8) with backlight for use in Finland and Sweden (includes keyboard
cable, pointing stick and pointing stick cable)

701978-BG1 A Keyboard (Windows 8) with backlight for use in Switzerland (includes keyboard cable,
pointing stick and pointing stick cable)

701978-D61 A Keyboard (Windows 8) with backlight for use in India (includes keyboard cable, pointing
stick and pointing stick cable)

701978-DB1 A Keyboard (Windows 8) with backlight for use in Canada (includes keyboard cable,
pointing stick and pointing stick cable)
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701978-FL1 A Keyboard (Windows 8) with backlight for use in Czechoslovakia (includes keyboard
cable, pointing stick and pointing stick cable)

702080–001 A Intel® Centrino™ 2430, EV-DO/HSPA minicard WLAN module

705053–001 N 128 GB solid-state drive (includes bracket)

710788–001 A F5321GWX HSPA + with GPS mini
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4 Removal and replacement procedures

Preliminary replacement requirements
Tools required

You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screwdriver

● Magnetic screwdriver

● Phillips P0 and P1 screwdrivers

● Torx T8 screwdriver

● 5.0 mm hex socket driver

Service considerations
The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts
Using excessive force during disassembly and reassembly can damage plastic parts. Use care when
handling the plastic parts. Apply pressure only at the points designated in the maintenance
instructions.
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Cables and and pointing stick connectors
CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to
unseat or seat the cables during removal and insertion. Handle cables by the connector whenever
possible. In all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in
such a way that they cannot be caught or snagged by parts being removed or replaced. Handle flex
cables with extreme care; these cables tear easily.

Drive handling
CAUTION: Drives are fragile components that must be handled with care. To prevent damage to
the computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the operating
system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage
Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated and pointing stick circuits
provide some protection, but in many cases, ESD contains enough power to alter device parameters
or melt silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and and pointing stick can work
perfectly throughout a normal cycle. Or the device may function normally for a while, then degrade in
the internal layers, reducing its life expectancy.

CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you area ready to install them.

Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines
described in this section.

Avoid touching pins, leads, and pointing stick circuitry. Handle electronic components as little as
possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.

CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand and pointing stick contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved and pointing stick
containers or packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

● Use transporters and pointing stick conveyors made of antistatic belts and roller bushings. Be
sure that mechanized equipment used for moving materials is wired to ground and that proper
materials are selected to avoid static charging. When grounding is not possible, use an ionizer to
dissipate electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded
tools and equipment.

● Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

● Keep the work area free of non conductive materials, such as ordinary plastic assembly aids and
Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

● Avoid and pointing stick contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible
straps with a minimum of one megohm ±10% resistance in the ground and pointing stick cords.
To provide proper ground, wear a strap snugly against the skin at all times. On grounded mats
with banana-plug connectors, use alligator clips to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive strips
must be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground and pointing stick cords of one megohm
resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Non conductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastic Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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Component replacement procedures
This chapter provides removal and replacement procedures.

There are as many as 98 screws and screw locks that must be removed, replaced, or loosened when
servicing the computer. Make special note of each screw and screw lock size and location during
removal and replacement.

Service tag and PCID label

Service tag
When ordering parts or requesting information, provide the computer serial number and model
number provided on the service tag.

Item Component Description

(1) Product name This is the product name affixed to the front of the
computer.

(2) Serial number (s/n) This is an alphanumeric identifier that is unique to each
product.

(3) Part number/Product number (p/n) This number provides specific information about the
product’s hardware components. The part number helps
a service technician determine what components and
parts are needed.

(4) Warranty period This number describes the duration of the warranty
period for the computer.

PCID label
The PCID label provides the information required to properly reset the notebook firmware (BIOS)
back to factory shipped specifications when replacing the system board. The label may have a
different number of characters depending on the operating system on the computer.

NOTE: Computer details may vary from images.
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Windows 8 models

Non Windows 8 models
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Computer feet
The computer feet (not illustrated) are adhesive-backed rubber pads. The feet are included in the
base enclosure spare part kit, spare part number 688765-001. The rubber feet that attach to the base
enclosure in the locations illustrated below.

Battery

Description Spare part number

8-cell, Li-ion 2.8 Ah (75 WHr) 632425-001

8-cell, Li-ion 2.8 Ah (83 WHr) 632427-001

9–cell, Li-ion 3.0 Ah (100 WHr) 634087-001

9–cell, Li-ion 2.2 Ah (73 WHr) 634089-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery:

1. Position the computer upside down on a flat surface, with the front toward you.

2. Slide the battery release latch to the left (1) to release the battery.

3. Pivot the battery (2) upward and lift it out of the computer (3).

Install the battery by inserting it into the battery bay until you hear a click.
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SIM
Before removing the SIM, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51).

Remove the SIM:

1. Press in on the SIM (1) to release it from the SIM slot.

2. Remove the SIM (2) from the SIM slot.

Install the SIM by inserting it into the SIM slot until you hear a click.

Service access cover

Description Spare part number

Service access cover 698410-001

Service access cover (RCTO) 699467-001

Before removing the service access cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.
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3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51).

Remove the service access cover:

1. Position the computer upside down on a flat surface, with the front toward you.

2. Slide the service cover release latch to the right (1), and remove the single security screw (2), if
it has been installed.

3. Slide the service access cover release latch to the right (3) to release the service access cover.

4. Slide the service access cover toward the front of the computer (4) and then remove the cover
(5).

Reverse this procedure to reassemble and install the service cover. When reinstalling the service
cover, install the security screw in the area that is adjacent to the service cover release latch. The
security screw is located on the service cover.
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Primary hard drive
NOTE: The hard drive bracket is included in the Hard Drive Hardware Kit, spare part number
642774-001.

Description Spare part number

750 GB, 7200-rpm SATA hard drive 633252-001

500 GB, 7200-rpm SATA hard drive 634925-001

500 GB, 7200-rpm SATA SED hard drive 634862-001

24 GB solid-state drive (includes bracket and screws) 701479–001

Before removing the primary hard drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51).

5. Remove the service access cover (see Service access cover on page 52).

6. Position the computer with the front toward you.

7. Loosen the captive screw on the Smart Card reader (1).
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8. Lift the Smart Card reader to the upright position (2).

9. Loosen the Phillips M2.5x10.5 captive screws (1) that secure the hard drive to the computer.

10. Grasp the tab on the hard drive and slide the hard drive (2) to disconnect it from the system
board.

11. Lift the left side of the hard drive and remove the hard drive at an angle from the hard drive bay
(3).

12. If it is necessary to remove the hard drive bracket, follow these steps:

a. Remove the four Phillips M3.0x3.0 screws (1) that secure the hard drive bracket to the hard
drive.
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b. Lift the bracket (2) straight up to remove it from the hard drive.

Reverse this procedure to reassemble and install the hard drive.

Secondary hard drive
NOTE: The hard drive bracket is included in the Hard Drive Hardware Kit, spare part number
642774-001.

Description Spare part number

750 GB, 7200-rpm SATA hard drive 633252-001

500 GB, 7200-rpm SATA hard drive 634925-001

320 GB, 7200-rpm SATA hard drive 634862-001

24 GB solid-state drive (includes bracket and screws) 701479–001

Before removing the secondary hard drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51).

5. Remove the service access cover (see Service access cover on page 52).

Remove the secondary hard drive:

1. Position the computer with the front toward you.

2. Loosen the Phillips M2.5x10.5 captive screws (1) that secure the hard drive to the computer.
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3. Grasp the tab and slide the hard drive (2) to the right. Lift the hard drive up to remove it from the
hard drive bay (3).

4. If it is necessary to remove the hard drive bracket, follow these steps:

a. Remove the four Phillips M3.0x3.0 screws (1) that secure the hard drive bracket to the hard
drive.

b. Lift the bracket (2) straight up to remove it.

Reverse this procedure to reassemble and install the secondary hard drive.

Component replacement procedures 57



Smart Card reader

Description Spare part number

Smart Card reader (with cable) 688742-001

Smart Card reader cover 652546-001

Before removing the Smart Card reader, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51).

5. Remove the service access cover (see Service access cover on page 52).

6. Position the computer with the front toward you.

7. Disconnect the zero insertion force (ZIF) connector (1), lift up the smart card reader until it is
almost vertical (2), and then remove the smart card reader (3).

8. Remove the Phillips M3.0x2.5 screw (1) that secures the Smart Card reader board to the Smart
Card reader cover.
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9. Slide the Smart Card reader back toward the hinges on the Smart Card reader cover, and
remove the Smart Card reader board (2).

Reverse this procedure to reassemble and install the Smart Card reader.

Bluetooth module
NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The
Bluetooth module cable is included in the Cable Kit, spare part number 652545-001. See Bluetooth
module cable on page 103 for information on replacing the Bluetooth module cable.

Description Spare part number

Bluetooth module 655792–001

Before removing the Bluetooth module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51).

5. Remove the service access cover (see Service access cover on page 52).
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Remove the Bluetooth module:

1. Remove the Bluetooth module cover.

2. Gently pry the Bluetooth module away from the adhesive in the base enclosure and lift the
Bluetooth module (1).

3. Disconnect the Bluetooth module from the Bluetooth cable (2), and remove the module.

Reverse this procedure to install the Bluetooth module.

WLAN module

Description Spare part number

Intel® Centrino™ Advanced-N 6205, 802.11a/b/g/n WLAN module 695915-001
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Description Spare part number

Intel Centrino Ultimate-N 6300, 802.11a/b/g/n WLAN module 698588-001

Broadcom 802.11a/b/g/n 2x2WiFi Adapter 669832-001

CAUTION: The WLAN module and the WWAN module are not interchangeable.

To prevent an unresponsive system, replace the wireless module only with a wireless module
authorized for use in the computer by the governmental agency that regulates wireless devices in
your country or region. If you replace the module and then receive a warning message, remove the
module to restore device functionality, and then contact technical support.

Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51).

5. Remove the service access cover (see Service access cover on page 52).

Remove the WLAN module:

1. Position the computer with the front toward you.

2. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

NOTE: The WLAN antenna cables are numbered and connect from left to right on the WLAN
module.

3. Remove the two Phillips M2.0×2.0 screws (2) that secure the WLAN module to the system
board. (The WLAN module tilts up.)

4. Remove the WLAN module (3) by pulling the module away from the slot at an angle.

NOTE: WLAN modules are designed with a notch (4) to prevent incorrect insertion of the
WLAN module into the WLAN module slot.

Reverse this procedure to install the WLAN module.
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WWAN module

Description Spare part number

HP un2430 EV-DO/HSPA Mobile Broadband Module 634400-001

HP hs2340 HSPA+ Mobile Broadband Module 668969-001

HP un2430 EV-DO/HPSA minicard9999 702080-001

HSPA+ with GPS minicard 710788–001

CAUTION: The WWAN module and the WLAN module are not interchangeable.

To prevent an unresponsive system, replace the wireless module only with a wireless module
authorized for use in the computer by the governmental agency that regulates wireless devices in
your country or region. If you replace the module and then receive a warning message, remove the
module to restore device functionality, and then contact technical support.

Before removing the WWAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51).

5. Remove the service access cover (see Service access cover on page 52).

Remove the WWAN module:

1. Disconnect the WWAN antenna cables (1) from the terminals on the WWAN module.

NOTE: The red WWAN antenna cable is connected to the WWAN module “Main” terminal. The
blue WWAN antenna cable is connected to the WWAN module “Aux” terminal.

2. Remove the two Phillips M2.0×2.0 screws (2) that secure the WWAN module to the system
board. (The WWAN module tilts up.)

3. Remove the WWAN module (3) by pulling the module away from the slot at an angle.
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Reverse this procedure to install the WWAN module.

RTC battery

Description Spare part number

RTC battery 651948-001

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51).

5. Remove the service access cover (see Service access cover on page 52).

Remove the RTC battery:

▲ Disconnect the RTC battery cable (1) from the system board and remove the RTC battery (2).

NOTE: You may need to remove some double-sided adhesive.

Reverse this procedure to install the RTC battery.

Optical drive
NOTE: The upgrade bay supports both optical drives and hard drives. If you switch from a hard
drive to an optical drive in the upgrade bay, you will need to remove four additional screws that
secure the hard drive carrier.

Description Spare part number

Blu-ray R/RE DVD±RW SuperMulti Double-Layer Drive 688772-001

DVD±RW SuperMulti Double-Layer Drive 688770-001
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Description Spare part number

Blu-ray ROM DVD±RW SuperMulti Double-Layer Drive 688771-001

DVD-ROM Drive 688769-001

Before removing the optical drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51).

5. Remove the service access cover (see Service access cover on page 52).

Remove the optical drive:

1. Position the computer with the front toward you.

2. Loosen the Phillips captive screw (1) that secures the optical drive to the computer.

3. Insert a flat-bladed screwdriver or similar tool into the optical drive tab access (2) and press the
tab to the left to release the optical drive from the computer.

4. Remove the optical drive (3).
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5. If it is necessary to replace the optical drive bracket:

a. Position the optical drive with the rear toward you.

b. Remove the three Phillips M2.0×3.0 screws (1) that secure the optical drive bracket to the
optical drive.

c. Remove the optical drive bracket (2).

6. If it is necessary to remove the optical drive bezel:

a. Insert the end of a paper clip into the release access hole (1) in the optical drive bezel.
Press in gently until the tray is released.

b. Firmly pull outward on the open tray (2) until the optical drive slides out.
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c. Firmly pull outward on the bezel to remove the bezel from the optical drive tray.

Reverse this procedure to reassemble and install the optical drive.

Upgrade bay hard drive
NOTE: The hard drive bracket is included in the Hard Drive Hardware Kit, spare part number
642774-001.

Description Spare part number

7.0 mm, 9.5 mm, or 12.7 mm 500 GB hard drive, 7200 rpm 634925-001

Before removing the upgrade bay hard drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51).

5. Remove the service access cover (see Service access cover on page 52).

Remove the upgrade bay hard drive:

1. Position the computer with the front toward you.
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2. Remove the four Phillips PM3.0×3.0 screws that secure the upgrade bay hard drive carrier to the
computer.

3. Loosen the 2 Phillips captive screws (1) that secure the hard drive to the carrier.

4. Insert a flat-bladed screwdriver or similar tool into the upgrade bay hard drive tab access (2) and
press the tab to the left to release the upgrade bay hard drive from the computer.

5. Lift and remove the upgrade bay hard drive (3), and then remove the hard disk drive interface
connector (4).

Reverse this procedure to reassemble and install the upgrade bay hard drive and upgrade bay hard
drive carrier.

Primary memory module
NOTE: Primary memory is installed under the keyboard.
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A computer having a system board with spare part number 690034-001 or 688745-001 has two
memory slots (primary memory slots). When adding or replacing memory modules, slot 1 must be
populated before slot 2 is populated.

A computer having a system board with spare part number 688746-001 or 690035-001 has four
memory slots (expansion memory slots) (on the bottom of the computer) and the primary memory
slots (under the keyboard). Slot 2 cannot be populated if slot 1 is not populated.

Description Spare part number

8192 MB memory module (PC3-12800, 1600 MHz, DDR3) 670034-001

4096 MB memory module (PC3-12800, 1600 MHz, DDR3) 641369-001

2048 MB memory module (PC3-12800, 1600 MHz, DDR3) 652972-001

NOTE: A memory module must be installed in the bottom primary memory module slot before a
memory module is installed in the top primary memory module slot.

Before removing a primary memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51).

5. Remove the service access cover (see Service access cover on page 52)

6. Remove the hard drive (see Primary hard drive on page 54).

7. Remove the keyboard (see Keyboard on page 71).

Remove the primary memory module:

1. Spread the retaining tabs (1) on each side of the primary memory module slot to release the
primary memory module. (The edge of the module opposite the slot rises away from
the computer.)

2. Remove the primary memory module (2) by pulling the module away from the slot at an angle.

NOTE: Memory modules are designed with a notch (3) to prevent incorrect installation into the
primary memory module slots.
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Reverse this procedure to install a primary memory module.

Expansion memory module
NOTE: Expansion memory slots are located in a compartment on the bottom of the computer.

A computer having a system board with spare part number 690034-001 or 688745-001 has two
memory slots, which are called primary memory slots in this MSG. When you add or replace memory
modules, slot 1 must be populated before slot 2 is populated.

A computer having a system board with spare part number 688746-001 or 690035-001 has four
memory slots. On these computers, in both the expansion memory slots (on the bottom of the
computer) and the primary memory slots (under the keyboard), slot 1 must be populated before slot 2
is populated.

Description Spare part number

8192 MB memory module (PC3-12800, 1600 MHz, DDR3) 670034-001

4096 MB memory module (PC3-12800, 1600 MHz, DDR3) 641369-001

2048 MB memory module (PC3-12800, 1600 MHz, DDR3) 652972-001

NOTE: A memory module must be installed in the right expansion memory module slot before a
memory module is installed in the left expansion memory module slot.

Before removing an expansion memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51).

5. Remove the service access cover (see Service access cover on page 52).

Remove an expansion memory module:

1. Spread the retaining tabs (1) on each side of the expansion memory module slot to release the
expansion memory module. (The edge of the module opposite the slot rises away from
the computer.)
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2. Remove the expansion memory module (2) by pulling the module away from the slot at an
angle.

NOTE: Memory modules are designed with a notch (3) to prevent incorrect installation into the
expansion memory module slots.

Reverse this procedure to install an expansion memory module.
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Keyboard

For use in: Spare part number For use in: Spare part number

Keyboard with backlight (includes keyboard cable, pointing stick and pointing stick cable):

Belgium 688738-A41 Norway 688738-091

Denmark 688738-081 Russia 688738–251

Finland and Sweden 688738-B71 France 688738-051

Germany 688738-041 South Korea 688738-AD1

Thailand 688738-281 Switzerland 688738-BG1

International 688738-B31 Taiwan 688738-AB1

The United States 688738-001 The United Kingdom and Singapore 688738-031

Italy 688738-061 Latin America 688738-161

India 688738–D61 Canada 688738–DB1

Czech Republic and Slovakia 688738–FL1

Keyboard without backlight (includes keyboard cable, pointing stick and pointing stick cable):

Belgium 688737-A41 Greece 688737-151

Brazil 688737-201 Norway 688737-091

Bulgaria 688737-261 Portugal 688737-131

Taiwan 688737-AB1 Russia 688737-251

Denmark 688737-081 Saudi Arabia 688737-171

Finland and Sweden 688737-B71 Slovenia 688737-BA1

France 688737-051 South Korea 688737-AD1

Latin America 688737–161 Spain 688737-071

Germany 688737-041 Switzerland 688737-BG1

Romania 688737–271 Northwest Africa 688737–FP1

Hungary 688737-211 Thailand 688737-281

Iceland 688737-DD1 Turkey 688737-141

International 688737-B31 The United Kingdom and Singapore 688737-031

Israel 688737-BB1 The United States 688737-001

Italy 688737-061 India 688737–D61

Japan 688737-291 Canada 688737–DB1

Czech Republic and Slovakia 688737–FL1   

Windows 8 Keyboard without backlight (includes keyboard cable, pointing stick and pointing stick cable):

United States 701977–001 Northwest Africa 701977-FP1

The United Kingdom and Singapore 701977-031 Germany 701977-041

France 701977-051 Italy 701977-061
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For use in: Spare part number For use in: Spare part number

Spain 701977-071 Denmark 701977-081

Norway 701977-091 Portugal 701977-131

Turkey 701977-141 Greece 701977-151

Latin America 701977-161 Saudi Arabia 701977-171

Brazil 701977-201 Hungary 701977-211

Russia 701977-251 Bulgaria 701977-261

Romania 701977-271 Thailand 701977-281

Japan 701977-291 Belgium 701977-A41

Taiwan 701977-AB1 South Korea 701977-AD1

Internationally 701977-B31 Finland and Sweden 701977-B71

Slovenia 701977-BA1 Israel 701977-BB1

Switzerland 701977-BG1 India 701977-D61

Canada 701977-DB1 Iceland 701977-DD1

Czech Republic and Slovakia 701977-FL1   

Windows 8 Keyboard with backlight (includes keyboard cable, pointing stick and pointing stick cable):

The United States 701978-001 The United Kingdom and Singapore 701978-031

Germany 701978-041 France 701978-051

Italy 701978-061 Denmark 701978-081

Norway 701978-091 Latin America 701978-161

Russia 701978-251 Thailand 701978-281

Belgium 701978-A41 Taiwan 701978-AB1

South Korea 701978-AD1 Internationally 701978-B31

Sweden and Finland 701978-B71 Switzerland 701978-BG1

India 701978-D61 Canada 701978-DB1

Czech Republic and Slovakia 701978-FL1   

Before removing the keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51).
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5. Remove the service access cover (see Service access cover on page 52).

6. Remove the optical drive (see Optical drive on page 63) or upgrade bay hard drive (see Upgrade
bay hard drive on page 66).

NOTE: The optical drive or hard drive carrier in the upgrade bay must be removed in order to
remove the keyboard.

Remove the keyboard:

1. Position the computer with the front toward you.

2. Loosen the three Phillips captive screws that secure the keyboard to the computer.

3. Position the computer on its side with the display open at a 90 degree angle.
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4. Insert a small tool at an angle through the hole in the optical drive bay at an angle to push out
the top edge of the keyboard. This gives you access to the back of the keyboard and releases
the top edge of the keyboard.

NOTE: Make sure that the optical drive or upgrade hard drive have been removed before
performing this procedure.

5. Turn the computer right-side up, with the front toward you.

6. Open the display as far as it will open.

7. Lift the top edge (1) of the keyboard until it rests at an angle.

8. Slide the keyboard back toward the display (2).

9. Release the keyboard ZIF connector (1) and lift the keyboard cable (2) to release it.
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10. Release the pointing stick ZIF connector (3) and lift the cable (4) to release it.

Reverse this procedure to install the keyboard.

Fan/graphics board heat sink assembly
NOTE: The fan/graphics board heat sink assemblies include replacement thermal material.

Description Spare part number

For use only with computer models equipped with AMD graphics subsystems 688733-001

For use only with computer models equipped with NVIDIA graphics subsystems 696435-001

NOTE: To properly ventilate the computer, allow at least a 7.6-cm (3-inch) clearance on the left side
of the computer. The computer uses an electric fan for ventilation. The fan is controlled by a
temperature sensor and is designed to turn on automatically when high temperature conditions exist.
These conditions are affected by high external temperatures, system power consumption, power
management/battery conservation configurations, battery fast charging, and software requirements.
Exhaust air is displaced through the ventilation grill located on the left side of the computer.

Before removing the graphics board heat sink, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51).
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5. Remove the service access cover (see Service access cover).

6. Remove the optical drive (see Optical drive on page 63) or upgrade bay hard drive (see Upgrade
bay hard drive on page 66).

7. Remove the keyboard (see Keyboard on page 71).

8. Remove the top cover (see Top cover on page 83)

9. Remove the display assembly (see Display assembly on page 88).

Remove the fan/graphics board heat sink assembly:

NOTE: Before proceeding, make sure you disconnect the power button board cable and the RJ-45
cable.

1. Following the sequence stamped into the graphics board heat sink, loosen the 4 Phillips captive
screws (1) that secure the graphics board heat sink/fan assembly to the system board.
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2. Lift the heat sink/fan assembly (2) straight up to remove it.

NOTE: Due to the adhesive quality of the thermal material located between the fan/graphics
board heat sink assembly and graphics board components, it may be necessary to move the
graphics board heat sink from side to side to detach it from the system board.

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the graphics
board heat sink and the graphics board each time the graphics board heat sink is removed:
Thermal paste is used on the largest component (1) and (2) on the graphics board and the
graphics board heat sink section (3) and (4) that service it.

Reverse this procedure to install the fan/graphics board heat sink assembly.
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Display bezel

Description Spare part number

Display bezel for use with computer models without a webcam 688763-001

Before removing the display bezel, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the display assembly (see Display assembly on page 88).

Remove the display bezel:

1. Remove the screw covers (1), the captive screw (2), and the two screws (3) that secure the
display bezel to the display enclosure.

2. Remove the screw covers securing the bezel to the display panel (1), and then remove the
screws (2).
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3. Flex the inside edges of the top edge (3), the left and right sides (4), and the bottom edge (5) of
the display bezel until the bezel disengages from the display enclosure and then remove the
bezel (6).

Reverse this procedure to install the display bezel.

Display panel

Description Spare part number

43.9 cm (17.3 in), HD+ AG LED WVA 691223-001

43.9 cm (17.3 in), FHD AG WVA 691224-001

Before removing the display panel, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the display assembly (see Display assembly on page 88).

5. Remove the display bezel (see Display bezel on page 78).

Remove the display panel:

1. Remove the 2 Torx screws on each hinge (1).

2. Remove the two Phillips rawhead screws (2) on the upper left and right corners of the display
panel.
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3. Remove the 1 Phillips screws (3) that secure the display panel brackets to the hinge pipe.

4. Slide the hinge pipe to the right (1) and remove the hinge pipe (2).

NOTE: Make sure you pull back the antenna cables when removing the hinge pipe.

5. Remove the display panel.

Reverse this procedure to reassemble and to install the display panel.
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Display panel cable

Description Spare part number

Display panel cable (select models only) 688761-001

To remove the display panel cable:

▲ Release the adhesive tape that secures the display panel cable to the display panel (1).
Disconnect the cable (2), and then remove the cable (3).

Hinge brackets

Description Spare part number

Display hinge brackets (consists of the hinge piece and the vertical support brackets for the left and
right sides)

652528-001

To remove the display panel hinge brackets:
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▲ Remove the 4 screws that secure each hinge assembly to the panel (1), and then remove the
hinge brackets (2).

Webcam module

Description Spare part number

Webcam module with microphone 688752-001

Before removing the webcam module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the display assembly (see Display assembly on page 88).

5. Remove the display panel (see Display panel on page 79).
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Remove the webcam module:

1. Lift the WLAN antenna cables (1), and then remove the WWAN antenna cables (2).

2. Remove the webcam cable (1) from the hinges and then disconnect the webcam cable from the
display enclosure (2).

3. Remove the webcam module from the display enclosure (3).

Reverse this procedure to install the webcam module.

Top cover

Description Spare part number

Top cover (includes TouchPad) 688747-001
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Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51).

5. Remove the service access cover (see Service access cover on page 52).

6. Remove the optical drive (see Optical drive on page 63) or upgrade bay hard drive (see Upgrade
bay hard drive on page 66).

7. Remove the keyboard (see Keyboard on page 71).

Remove the top cover:

1. Position the computer right-side up, with the front toward you.

2. Remove the 8 Torx M2.5x6.0 screws that secure the base enclosure to the top cover.
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3. Remove the two Phillips M2.5x3 screws in the optical drive/upgrade drive bay (1) and the four
Phillips M2.5x3.0 screws inside the battery bay (2).

4. Disconnect the power button board cable (1). Disconnect the TouchPad cable on the left (2) and
the right sides (3).

5. Disconnect the fingerprint reader cable (4) and then disconnect the application board cable (5).

6. Position the computer right-side up.
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7. Grasp the top cover by the hole in the optical disk drive/upgrade drive bay and lift up the front
edge of the top cover (1).

8. Remove the top cover from the base enclosure (2).

9. If it is necessary to replace the TouchPad:

a. Lift the adhesive tape (1), lift and release the TouchPad cable from the opening in top cover
(2), and then release the TouchPad cable (3).

b. Remove the three screws (1) securing the TouchPad to the top cover.

c. Release the TouchPad from the front clip (2) securing the TouchPad to the top cover.
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d. Release the TouchPad from the front right side clip (3) and then remove the TouchPad
from the top cover.

Reverse this procedure to install the top cover and TouchPad.

NOTE: In reversing this procedure, make sure that the display latch assembly actuator lines up
correctly with the top cover to avoid damaging any components.
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Display assembly

Description Spare part number

Display panel, 43.9 cm (17.3 in), High Definition Plus (HD+) Anti-Glare (AG) LED WVA without
webcam

691223-001

Display panel, 43.9 cm (17.3 in), FHD AG LED WVA 691224-001

43.9 cm (17.3 in), FHD AG RGB LED UVWA Dream Color with webcam (not available with HP
Mobile Broadband)

688736-001

43.9 cm (17.3 in), FHD AG RGB LED UVWA Dream Color without webcam (not available with HP
Mobile Broadband)

688735-001

Display Hinge Kit 652528-001

Display hinge covers 652529-001

Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51).

5. Remove the service access cover (see Service access cover on page 52).

6. Remove the optical drive (see Optical drive on page 63) or upgrade bay hard drive (see Upgrade
bay hard drive on page 66).

7. Remove the keyboard (see Keyboard on page 71).

8. Remove the top cover (see Top cover on page 83).

Remove the display assembly:

1. Position the computer upside down.
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2. Remove the tape (1) that secures the WLAN and WWAN cables to the system board. (2).

3. Turn the computer right side up, facing you. Feed the WLAN and WWAN cables through the
hole next to the keyboard screw (1), and then lift the cable free of the routing areas (2).
Disconnect the webcam cable (3).

4. Position the computer with the rear towards you.

CAUTION: Support the display assembly when removing the display screws in the following
steps. Failure to support the display assembly can result in damage to the assembly and other
components.
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5. Disconnect the display panel cable (1), and then remove the cable (2).

NOTE: Make sure all cables are freed from the clips in the routing channel.

6. Turn the unit around, and then remove the Torx M2.5x7.0 screws (1) that secure the display
hinges to the base enclosure. Next, remove the Torx M2.5x3.0 screws (2) that secure the hinge
cover to the base enclosure. Remove the four 8 millimeter Torx screws (3) that secure the hinge
cover to the base enclosure.
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7. Position the computer with the rear toward you. Lift the rear hinges and remove.

8. Remove the two 6 millimeter Torx screws securing the display panel to the base enclosure (1)`,
and then remove the display panel (2).

Reverse this procedure to reassemble and to install the display assembly.

Power button board

Description Spare part number

Power button board 688749-001
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Before removing the power button board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51)

5. Remove the service access cover (see Service access cover on page 52).

6. Remove the optical drive (see Optical drive on page 63) or upgrade bay hard drive (see Upgrade
bay hard drive on page 66).

7. Remove the keyboard (see Keyboard on page 71).

8. Remove the top cover (see Top cover on page 83).

Remove the power button board:

1. Position the top cover upside down with the front toward you.

2. Slide the power button board cable out from the clips in the top cover (1).

3. Remove the conductive tape (2) that secures the power button board cable to the top cover.

4. Remove the two Phillips M2.5x3.0 screws (3) that secure the power button board to the top
cover, and then remove the power button board (4).

Reverse this procedure to install the power button board.

Application button board

Description Spare part number

Application button board 696901-001
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Before removing the application button board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51).

5. Remove the service access cover (see Service access cover on page 52).

6. Remove the optical drive (see Optical drive on page 63) or upgrade bay hard drive (see Upgrade
bay hard drive on page 66).

7. Remove the keyboard (see Keyboard on page 71).

8. Remove the top cover (see Top cover on page 83).

Remove the application button board:

1. Position the top cover upside down with the front toward you.

2. Slide the application button board cable (1) out from the clip in the top cover.

3. Remove the two Phillips M2.5x3.0 screws (2) that secure the application button board to the top
cover.

4. Remove the application button board (3).

Reverse this procedure to install the application button board.

Fingerprint reader

Description Spare part number

Fingerprint reader 688743-001
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Before removing the fingerprint reader, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51)

5. Remove the service access cover (see Service access cover on page 52).

6. Remove the optical drive (see Optical drive on page 63) or upgrade bay hard drive (see Upgrade
bay hard drive on page 66).

7. Remove the keyboard (see Keyboard on page 71).

8. Remove the top cover (see Top cover on page 83).

Remove the fingerprint reader:

1. Position the top cover upside down with the front toward you.

2. Slide the fingerprint reader cable (1) out from the 3 clips in the top cover and remove it.

3. Peel off the tape (2) that secures the fingerprint reader to the top cover.

4. Lift the fingerprint reader (3) from the top cover.

Reverse this procedure to install the fingerprint reader.

Audio/USB 2.0 board

Description Spare part number

Audio/USB 2.0 board 689284-001
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Before removing the Audio/USB 2.0 board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51),

5. Remove the service access cover (see Service access cover on page 52).

6. Remove the optical drive (see Optical drive on page 63) or upgrade bay hard drive (see Upgrade
bay hard drive on page 66).

7. Remove the keyboard (see Keyboard on page 71).

8. Remove the top cover (see Top cover on page 83).

Remove the audio/USB 2.0 board:

1. Position the computer right-side up with the front toward you.

2. Remove the three Phillips M2.5x3.0 screws (1) that secure the audio/USB 2.0 board to the base
enclosure.

3. Disconnect the speaker cable (2) from the Audio/USB 2.0 board.

4. Lift the left edge of the audio/USB 2.0 board to disconnect it from the system board and remove
the audio/USB 2.0 board (3) at an angle to the left from the base enclosure

Reverse this procedure to install the audio/USB 2.0 board.
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Speaker assembly

Description Spare part number

Speaker assembly 652540-001

Before removing the speaker assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51).

5. Remove the service access cover (see Service access cover on page 52).

6. Remove the optical drive (see Optical drive on page 63) or upgrade bay hard drive (see Upgrade
bay hard drive on page 66).

7. Remove the keyboard (see Keyboard on page 71).

8. Remove the top cover (see Top cover on page 83).

9. Remove the Smart Card reader (see Smart Card reader on page 58).

10. Remove the Audio/USB 2.0 board (see Audio/USB 2.0 board on page 94).

Remove the speaker assembly:

1. Remove the two Phillips M2.5x6.0 screws (1) that secure the speaker assembly to the base
enclosure.
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2. Gently flex the band on the base enclosure next to the speaker assembly, and remove the
speaker assembly (2).

Reverse this procedure to install the speaker assembly.

Modem module
NOTE: The modem module spare part kit does not include a modem module cable. The modem
module cable is included in the Cable Kit, spare part number 652545-001. See Modem module cable
on page 100 for information on replacing the modem module cable.

Description Spare part number

56K V.92 1data/fax modem 628824-001

Before removing the modem module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51).

5. Remove the service access cover (see Service access cover on page 52).
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6. Remove the optical drive (see Optical drive on page 63) or upgrade bay hard drive (see Upgrade
bay hard drive on page 66).

7. Remove the keyboard (see Keyboard on page 71).

8. Remove the top cover (see Top cover on page 83).

9. Remove the Smart Card reader (see Smart Card reader on page 58).

10. Remove the Audio/USB 2.0 board (see Audio/USB 2.0 board on page 94).

Remove the modem module:

1. Position the computer right-side up with the front toward you.

2. Remove the two Phillips M2.0x3.0 screws (1) that secure the modem to the system board.

3. Lift the modem upwards (2).

4. Disconnect the modem cable (3) from the modem.

Reverse this procedure to install the modem module.

Display (VGA) port
Before removing the modem module cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51).

5. Remove the service access cover (see Service access cover on page 52).

6. Remove the optical drive (see Optical drive on page 63) or upgrade bay hard drive (see Upgrade
bay hard drive on page 66).
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7. Remove the keyboard (see Keyboard on page 71).

8. Remove the top cover (see Top cover on page 83).

9. Remove the Smart Card reader (see Smart Card reader on page 58).

10. Remove the Audio/USB 2.0 board (see Audio/USB 2.0 board on page 94).

Remove the VGA port:

▲ Remove the Phillips screw (1) that secures the display (VGA) port to the base enclosure. Lift the
port (2) up at an angle to remove it.
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Modem module cable
NOTE: The modem module cable is included in the Cable Kit, spare part number 652545-001.

Before removing the modem module cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51).

5. Remove the service access cover (see Service access cover on page 52).

6. Remove the optical drive (see Optical drive on page 63) or upgrade bay hard drive (see Upgrade
bay hard drive on page 66).

7. Remove the keyboard (see Keyboard on page 71).

8. Remove the top cover (see Top cover on page 83).

9. Remove the Smart Card reader (see Smart Card reader on page 58).

10.

1. Remove the Audio/USB 2.0 board (see Audio/USB 2.0 board on page 94).

2. Remove the modem module (see Modem module on page 97).

Remove the modem module cable:

1. Position the computer right side-up with the front toward you.

2. Remove the modem cable from the routing clips in the base enclosure.

3. Loosen the Torx M2.0x3.0 screw from the side black trim piece (1).

4. Gently pry the modem module cable out from the base enclosure (2), and then remove cable (3).
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Reverse this procedure to install the modem module cable.
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Card reader/USB 3.0 board

Description Spare part number

Card reader/USB 3.0 board 689283-001

Before removing the card reader/USB 3.0 board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51).

5. Remove the service access cover (see Service access cover on page 52).

6. Remove the optical drive (see Optical drive on page 63) or upgrade bay hard drive (see Upgrade
bay hard drive on page 66).

7. Remove the keyboard (see Keyboard on page 71).

8. Remove the top cover (see Top cover on page 83).

Remove the card reader/USB 3.0 board:

1. Position the computer right-side up with the front toward you.

2. Remove any plastic blanks in the card reader slots.

3. Remove the 3 Phillips M2.5x3.0 screws (1) that secure the card reader/USB 3.0 board to the
base enclosure.

4. Lift the left side (2) of the card reader/USB 3.0 board to disconnect it from the system board.

Reverse this procedure to install the card reader/USB 3.0 board.
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Bluetooth module cable
NOTE: The Bluetooth module cable is included in the Cable Kit, spare part number 652545-001.

Before removing the Bluetooth module cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51).

5. Remove the service access cover (see Service access cover on page 52).

6. Remove the optical drive (see Optical drive on page 63) or upgrade bay hard drive (see Upgrade
bay hard drive on page 66).

7. Remove the keyboard (see Keyboard on page 71).

8. Remove the top cover (see Top cover on page 83).

9. Remove the bluetooth module (see Bluetooth module on page 59).

10. Remove the card reader/USB 3.0 board (see Card reader/USB 3.0 board on page 102).

Remove the Bluetooth module cable:

1. Position the computer right-side up with the front toward you.

2. Disconnect the Bluetooth cable (1) from the system board.

3. Remove the Bluetooth cable (2).

Reverse this procedure to install the Bluetooth module cable.

System board
NOTE: All system board spare part kits include replacement thermal material.
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NOTE: Models that support quad-core processors have four memory slots. Models that support
dual-core processors have two memory slots.

Description Spare part number

For use in all countries and regions except the People's Republic of China:

● For use with computer models equipped with Intel quad-core processors 688746-001

● For use with computer models equipped with Intel dual-core processors 688745-001

For use only in the People's Republic of China:

● For use with computer models equipped with Intel quad-core processors 690035-001

● For use with computer models equipped with Intel dual-core processors 690034-001

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51).

5. Remove the service access cover (see Service access cover on page 52).

6. Remove the optical drive (see Optical drive on page 63) or upgrade bay hard drive (see Upgrade
bay hard drive on page 66).

7. Remove the keyboard (see Keyboard on page 71).

8. Remove the top cover (see Top cover on page 83).

9. Remove the display assembly (see Display assembly on page 88).

10. Remove the fan/graphics board heat sink (see Fan/graphics board heat sink assembly
on page 75).

11. Remove the processor heat sink (see Processor heat sink on page 110).

12. Remove the audio/USB 2.0 board (see Audio/USB 2.0 board on page 94).

13. Remove the speaker assembly (see Speaker assembly on page 96).

14. Remove the Card reader/USB 3.0 board (see Card reader/USB 3.0 board on page 102).

When replacing the system board, be sure that the following additional components are removed
from the defective system board and installed on the replacement system board:

● SIM (see SIM on page 52)

● Bluetooth module and cable (see Bluetooth module on page 59 and Bluetooth module cable
on page 103)

● WLAN module (see WLAN module on page 60)

● WWAN module (see WWAN module on page 62)

● RTC battery (see RTC battery on page 63)

104 Chapter 4   Removal and replacement procedures



● Primary memory modules (see Primary memory module on page 67)

● Expansion memory modules (see Expansion memory module on page 69)

● Graphics board (see Graphics board on page 115)

● Processor heat sink (see Processor heat sink on page 110)

● Processor (see Processor on page 112)

● Modem module (see Modem module on page 97)

Remove the system board:

1. Disconnect the power connector cable (1) from the system board.

2. Disconnect the network cable (2) from the system board.

3. Remove the 2 captive screws securing the fan (1).
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4. Remove the 4 Phillips M2.5x3.0 screws (marked with a triangle icon) that secure the system
board to the base enclosure (2), and then remove the short stand off screw (3) and the tall stand
off screw (4).

5. Lift up on the right side of the system board (1), and then remove the system board (2) by sliding
it out.

Reverse this procedure to install the system board.
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Network cable and jack
NOTE: The network cable is included in the Cable Kit, spare part number 652545-001.

Before removing the network cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51).

5. Remove the service access cover (see Service access cover on page 52).

6. Remove the optical drive (see Optical drive on page 63) or upgrade bay hard drive (see Upgrade
bay hard drive on page 66).

7. Remove the keyboard (see Keyboard on page 71).

8. Remove the top cover (see Top cover on page 83).

9. Remove the display assembly (see Display assembly on page 88).

10. Remove the fan/graphics board heat sink (see Fan/graphics board heat sink assembly
on page 75).

11. Remove the processor heat sink (see Processor heat sink on page 110).

Remove the network cable:

▲ Remove the network cable from the sideband on the base enclosure.

Reverse this procedure to install the network cable.

Power connector cable
The power connector cable is included in the Cable Kit, spare part number 652545-001.
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Before removing the power connector cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51).

5. Remove the service access cover (see Service access cover on page 52).

6. Remove the optical drive (see Optical drive on page 63) or upgrade bay hard drive (see Upgrade
bay hard drive on page 66).

7. Remove the keyboard (see Keyboard on page 71).

8. Remove the top cover (see Top cover on page 83).

9. Remove the display assembly (see Display assembly on page 88).

10. Remove the fan/graphics board heat sink (see Fan/graphics board heat sink assembly
on page 75).

11. Remove the processor heat sink (see Processor heat sink on page 110).

Remove the power connector cable:

▲ Remove the power connector cable jack from the base enclosure.

Reverse this procedure to install the Power connector cable.

Security lock
The security lock is included with the base enclosure assembly, spare part number 652535-001.
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Before removing the security lock, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51).

5. Remove the service access cover (see Service access cover on page 52).

6. Remove the optical drive (see Optical drive on page 63) or upgrade bay hard drive (see Upgrade
bay hard drive on page 66).

7. Remove the keyboard (see Keyboard on page 71).

8. Remove the top cover (see Top cover on page 83).

9. Remove the display assembly (see Display assembly on page 88).

10. Remove the fan/graphics board heat sink (see Fan/graphics board heat sink assembly
on page 75).

11. Remove the processor heat sink (see Processor heat sink on page 110).

12. Remove the audio/USB 2.0 board (see Audio/USB 2.0 board on page 94).

13. Remove the speaker assembly (see Speaker assembly on page 96).

14. Remove the Card reader/USB 3.0 board (see Card reader/USB 3.0 board on page 102).

15. Remove the system board (see System board on page 103).

Remove the security lock:

1. Position the computer right-side up with the front toward you.

2. Remove the Torx T9M2.5×6.0 screw (1) that secures the security lock to the base enclosure.

Component replacement procedures 109



3. Rotate the security lock away from the base enclosure and remove the security lock from the
base enclosure (2).

Reverse this procedure to install the security lock.

Processor heat sink

Description Spare part number

For use only with computer models equipped with quad-core processors 653629-001

For use only with computer models equipped with dual-core processors 652542-001

Before removing the processor heat sink, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51)

5. Remove the service access cover (see Service access cover on page 52).

6. Remove the optical drive (see Optical drive on page 63) or upgrade bay hard drive (see Upgrade
bay hard drive on page 66).

7. Remove the keyboard (see Keyboard on page 71).

8. Remove the top cover (see Top cover on page 83).

9. Remove the fan/graphics board heat sink assembly (see Fan/graphics board heat sink assembly
on page 75).
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Remove the processor heat sink:

1. Following the sequence stamped into the processor heat sink, loosen the four Phillips captive
screws (1) that secure the processor heat sink to the system board.

NOTE: Due to the adhesive quality of the thermal material located between the processor heat
sink and the processor, it may be necessary to move the processor heat sink from side to side to
detach it from the system board.

2. Lift the processor heat sink up and to the right at an angle and remove it from the base
enclosure (2).

NOTE: Thermal paste located on the surfaces of the processor (1) and the processor heat sink
(2) must be thoroughly removed and replaced each time the processor heat sink is removed.
Replacement thermal paste is included in the processor heat sink and processor spare part kits.

Reverse this procedure to install the processor heat sink.
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Processor
NOTE: The processor spare part kit includes replacement thermal material.

Description Spare part number

Next Generation Intel® Core™ processors, (support Intel Turbo Boost Technology) (includes replacement thermal
material):

i7-3610QM, 2.30 GHz (Turbo up to 3.30 GHz), 1600 MHz, 6 MB L3 Cache, 8 threads, 45W 680646-001

i7-3720QM, 2.60 GHz (Turbo up to 3.60 GHz), 1600 MHz, 6 MB L3 Cache, 8 threads, 45W 681283-001

i7-3820QM, 2.70 GHz (Turbo up to 3.70 GHz), 1600 MHz, 8 MB L3 Cache, 8 threads, 45W 681284-001

i7-3520M, 2.90 GHz (Turbo up to 3.60 GHz), 1600 MHz, 4 MB L3 Cache, 4 threads, 35W 681954-001

i7-3920XM, 2.90 GHz (Turbo up to 3.80 GHz), 1600 MHz, 8 MB L3 Cache, 8 threads, 55W 691351-001

Next Generation Intel® Core™ i5 processors, (support Intel Turbo Boost Technology) (includes
replacement thermal material):

 

i5-3360M, 2.80 GHz (Turbo up to 3.50 GHz), 1600 MHz, 3 MB L3 Cache, 4 threads, 35W 681953-001

i5-3320M, 2.60 GHz (Turbo up to 3.30 GHz), 1600 MHz, 3 MB L3 Cache, 4 threads, 35W 681952-001

Before removing the processor, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51)

5. Remove the service access cover (see Service access cover on page 52).

6. Remove the optical drive (see Optical drive on page 63) or upgrade bay hard drive (see Upgrade
bay hard drive on page 66).

7. Remove the keyboard (see Keyboard on page 71).

8. Remove the top cover (see Top cover on page 83).

9. Remove the fan/graphics board heat sink assembly (see Fan/graphics board heat sink assembly
on page 75).

10. Remove the processor heat sink (see Processor heat sink on page 110).

Remove the processor:

1. Use a flat-bladed screwdriver to turn the processor locking screw (1) one-half turn
counterclockwise, until you hear a click.
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2. Lift the processor (2) straight up and remove it.

NOTE: When you install the processor, the gold triangle (3) on the processor must be aligned
with the triangle (4) embossed on the processor socket.

Reverse this procedure to install the processor.
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Fan/Heat sink
▲ Remove the 4 screws securing the fan/heat sink (1), and then remove the fan/heat sink (2).

NOTE: Make sure the fan cable is disconnected from the system board.

NOTE: This diagram shows a view of of the processor (1) the paste (2), the board components
(3), and the pads (4). Thermal paste must be thoroughly removed and replaced each time the
processor heat sink is removed. Replacement thermal paste is included in the processor heat
sink and processor spare part kits.

114 Chapter 4   Removal and replacement procedures



Graphics board
NOTE: The graphics board spare part kit includes replacement thermal material.

Description Spare part number

AMD FirePro M5950 XT-GL 1GB GDDR5 (DP 1.2 and Eyefinity Plus support) 689279-001

NVIDIA Quadro 5010M, N14E-Q5 4 GB dedicated GDDR5 video memory 689282-001

NVIDIA Quadro 4000M, N14E-Q3 2 GB dedicated GDDR5 video memory 689281-001

NVIDIA Quadro 3000M, N14E-Q1 2 GB dedicated GDDR5 video memory 689280-001

Before removing the graphics board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51).

5. Remove the service access cover (see Service access cover on page 52).

6. Remove the optical drive (see Optical drive on page 63) or upgrade bay hard drive (see Upgrade
bay hard drive on page 66).

7. Remove the keyboard (see Keyboard on page 71).

8. Remove the top cover (see Top cover on page 83).

9. Remove the fan/graphics board heat sink assembly (see Fan/graphics board heat sink assembly
on page 75).

Remove the graphics board:

1. Remove the 2 Phillips M2.5×3.0 screws (1) that secure the graphics board to the system board.
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2. Lift the right edge of the graphics board until it rests at an angle and remove (2).

Reverse this procedure to install the graphics board.

Fan

Description Spare part number

Fan 688762-001

Before removing the fan, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51).

5. Remove the service access cover (see Service access cover on page 52).

6. Remove the optical drive (see Optical drive on page 63) or upgrade bay hard drive (see Upgrade
bay hard drive on page 66).

7. Remove the keyboard (see Keyboard on page 71).

8. Remove the top cover (see Top cover on page 83).

9. Remove the fan/graphics board heat sink assembly (see Fan/graphics board heat sink assembly
on page 75).

Remove the fan from the fan/graphics board heat sink assembly:

1. Remove the 3 Phillips PM2.0×3.0 screws (1) that secure the fan to the fan/graphics board heat
sink assembly.
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2. Remove the fan (2).

Reverse this procedure to install the fan into the fan/graphics board heat sink assembly.
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5 Computer Setup (BIOS) and Advanced
System Diagnostics

Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input
and output devices on the system (such as disk drives, display, keyboard, mouse, and printer).
Computer Setup includes settings for the types of peripherals installed, the startup sequence of the
computer, and the amount of system and extended memory.

NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the
computer from operating properly.

Windows 8 — Computer Setup (BIOS) and Advanced
System Diagnostics

Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input
and output devices on the system (such as disk drives, display, keyboard, mouse, and printer).
Computer Setup includes settings for the types of devices installed, the startup sequence of the
computer, and the amount of system and extended memory.

NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the
computer from operating properly.

Starting Computer Setup
NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

Navigating and selecting in Computer Setup
To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.
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NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.

To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes:

Click the Exit icon in the lower-left corner of the screen, and then follow the on-screen
instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

● To save your changes and exit Computer Setup menus:

Click the Save icon in the lower-left corner of the screen, and then follow the on-screen
instructions.

– or –

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup
NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select File > Restore Defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and
then follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.

Windows 8 — Computer Setup (BIOS) and Advanced System Diagnostics 119



Updating the BIOS
Updated versions of the BIOS may be available on the HP website.

Most BIOS updates on the HP website are packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.

Determining the BIOS version
To determine whether available BIOS updates contain later BIOS versions than those currently
installed on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed by pressing
fn+esc (if you are already in Windows) or by using Computer Setup.

1. Start Computer Setup.

2. Use a pointing device or the arrow keys to select File > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

Downloading a BIOS update
CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download
and install a BIOS update only when the computer is connected to reliable external power using the
AC adapter. Do not download or install a BIOS update while the computer is running on battery
power, docked in an optional docking device, or connected to an optional power source. During the
download and installation, follow these instructions:

Do not disconnect power on the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Sleep.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. From the Start screen, select the HP Support Assistant app.

2. Select Updates and tune-ups, and then select Check for HP updates now.

3. At the download area, follow these steps:

a. Identify the most recent BIOS update and compare it to the BIOS version currently installed
on your computer. Make a note of the date, name, or other identifier. You may need this
information to locate the update later, after it has been downloaded to your hard drive.

b. Follow the on-screen instructions to download your selection to the hard drive.

If the update is more recent than your BIOS, make a note of the path to the location on your
hard drive where the BIOS update is downloaded. You will need to access this path when
you are ready to install the update.

NOTE: If you connect your computer to a network, consult the network administrator before
installing any software updates, especially system BIOS updates.
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BIOS installation procedures vary. Follow any instructions that are displayed on the screen after the
download is complete. If no instructions are displayed, follow these steps:

1. From the Start screen, type e, and then click File Explorer.

2. Click your hard drive designation. The hard drive designation is typically Local Disk (C:).

3. Using the hard drive path you recorded earlier, open the folder on your hard drive that contains
the update.

4. Double-click the file that has an .exe extension (for example, filename.exe).

The BIOS installation begins.

5. Complete the installation by following the on-screen instructions.

NOTE: After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.

Windows 7 — Computer Setup (BIOS) and Advanced
System Diagnostics
Starting Computer Setup

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

Navigating and selecting in Computer Setup
To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or
the keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.
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To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.

– or –

● To save your changes and exit Computer Setup menus, click the Save icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then
press enter.

Your changes go into effect when the computer restarts.
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Restoring factory settings in Computer Setup
NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select File > Restore Defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and
then follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the
factory settings.

Updating the BIOS
Updated versions of the BIOS may be available on the HP Web site.

Most BIOS updates on the HP Web site are packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.

Determining the BIOS version
To determine whether available BIOS updates contain later BIOS versions than those currently
installed on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed as follows:

1. Start Computer Setup.

2. Use a pointing device or the arrow keys to select File > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.

NOTE: You can also determine the BIOS version by turning on or restarting the computer, pressing
the esc key while the “Press the ESC key for Startup Menu” message is displayed at the bottom of
the screen, and then pressing the f1 key. Follow the on-screen instructions to exit this screen.
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Downloading a BIOS update
CAUTION: CAUTION: To reduce the risk of damage to the computer or an unsuccessful
installation, download and install a BIOS update only when the computer is connected to reliable
external power using the AC adapter. Do not download or install a BIOS update while the computer is
running on battery power, docked in an optional docking device, or connected to an optional power
source. During the download and installation, follow these instructions:

Do not disconnect power from the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Suspend or Hibernation.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Open your Web browser. For U.S. support, go to http://www.hp.com/go/contactHP.
For worldwide support, go to http://welcome.hp.com/country/us/en/wwcontact_us.html.

2. Follow the on-screen instructions to identify your computer and access the BIOS update you
want to download.

3. Click the option for software and driver downloads, type your computer model number in the
product box, and then press enter. Follow the on-screen instructions to identify your computer
and access the BIOS update you want to download.

4. Click your specific product from the models listed.

5. Click the appropriate operating system.

6. Go to the BIOS section and download the BIOS software package.

7. Follow the installation instructions as provided with the downloaded BIOS software package.

NOTE: After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.
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Using Advanced System Diagnostics
Advanced System Diagnostics allows you to run diagnostic tests to determine if the computer
hardware is functioning properly. The following diagnostic tests are available in Advanced System
Diagnostics:

● Start-up test—This test analyzes the main computer components that are required to start
the computer.

● Run-in test—This test repeats the start-up test and checks for intermittent problems that the
start-up test does not detect.

● Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all
data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move
the data to a good sector.

● Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

● Battery test—This test analyzes the condition of the battery and calibrates the battery if
necessary. If the battery fails the test, contact support to report the issue and purchase a
replacement battery.

● System Tune-Up—This group of additional tests checks your computer to make sure that the
main components are functioning correctly. System Tune-Up runs longer and more
comprehensive tests on memory modules, hard drive SMART attributes, the hard drive surface,
the battery (and battery calibration), video memory, and the WLAN module status.

You can view system information and error logs in the Advanced System Diagnostics window.

To start Advanced System Diagnostics:

1. 1. Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press f2.

2. Click the diagnostic test you want to run, and then follow the on-screen instructions.

NOTE: If you need to stop a diagnostics test while it is running, press esc.

SUSE Linux — Computer Setup (BIOS)
NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

Starting Computer Setup
NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.
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To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

Using Computer Setup

Navigating and selecting in Computer Setup
To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.

To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

– or –

● To save your changes and exit Computer Setup menus, click the Save icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup
NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.
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3. Use a pointing device or the arrow keys to select File > Restore Defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and
then follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.

Updating the BIOS
Updated versions of the BIOS may be available on the HP website.

Most BIOS updates on the HP website are packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.

Determining the BIOS version
To determine whether available BIOS updates contain later BIOS versions than those currently
installed on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed as follows:

1. Start Computer Setup.

2. Use a pointing device or the arrow keys to select File > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

NOTE: You can also determine the BIOS version by turning on or restarting the computer, pressing
the esc key while the “Press the ESC key for Startup Menu” message is displayed at the bottom of
the screen, and then pressing the f1 key. Follow the on-screen instructions to exit this screen.
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Downloading a BIOS update
CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download
and install a BIOS update only when the computer is connected to reliable external power using the
AC adapter. Do not download or install a BIOS update while the computer is running on battery
power, docked in an optional docking device, or connected to an optional power source. During the
download and installation, follow these instructions:

Do not disconnect power from the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Suspend or Hibernation.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Open your Web browser and go to the HP website. For U.S. support, go to http://www.hp.com/
go/contactHP. For worldwide support, go to http://welcome.hp.com/country/us/en/
wwcontact_us.html.

2. Click the option for software and driver downloads, type your computer model number in the
product box, and then press enter. Follow the on-screen instructions to identify your computer
and access the BIOS update you want to download.

3. Click your specific product from the models listed.

4. Click the appropriate operating system.

5. Go to the BIOS section and download the BIOS software package.

6. Follow the installation instructions as provided with the downloaded BIOS software package.

NOTE: After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.

Using Advanced Diagnostics
Advanced System Diagnostics allows you to run diagnostic tests to determine if the computer
hardware is functioning properly. The following diagnostic tests are available in Advanced System
Diagnostics:

● Start-up test—This test analyzes the main computer components that are required to start the
computer.

● Run-in test—This test repeats the start-up test and checks for intermittent problems that the
start-up test does not detect.

● Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all
data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move
the data to a good sector.

● Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

● Battery test—This test analyzes the condition of the battery and calibrates the battery if
necessary. If the battery fails the test, contact support to report the issue and purchase a
replacement battery.

● System Tune-Up—This group of additional tests checks your computer to make sure that the
main components are functioning correctly. System Tune-Up runs longer and more
comprehensive tests on memory modules, hard drive SMART attributes, the hard drive surface,
the battery (and battery calibration), video memory, and the WLAN module status.

You can view system information and error logs in the Advanced System Diagnostics window.
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To start Advanced System Diagnostics:

1. Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press f2.

2. Click the diagnostic test you want to run, and then follow the on-screen instructions.

NOTE: If you need to stop a diagnostics test while it is running, press esc.
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6 Specifications

Computer specifications
 Metric U.S.

Dimensions

Width 41.70 cm 16.40 in

Depth 27.20 cm 10.70 in

Height (front to back) 3.70 cm to 4.30 cm 1.47 in to 1.68 in

Weight 3.60 kg 7.96 lbs

Input power

Operating voltage 19.5 V dc @ 4.74 A – 120 W

Operating current 4.74 A

Temperature

Operating 5°C to 35°C 41°F to 95°F

Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity (noncondensing)

Operating 10% to 90% 10% to 90%

Nonoperating 5% to 95% 5% to 95%

Maximum altitude (unpressurized)

Operating -15 m to 3,048 m -50 ft to 10,000 ft

Nonoperating -15 m to 12,192 m -50 ft to 40,000 ft

Shock

Operating 125 g, 2 ms, half-sine

Nonoperating 200 g, 2 ms, half-sine

Random vibration

Operating 0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep rate

Nonoperating 1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within
this range of temperatures.
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43.9 cm (17.3 in) WVA display specifications
 Metric U.S.

Dimensions

Width 24.4 cm 9.65 in

Depth 38.1 cm 15.0 in

Diagonal 43.9 cm 17.3 in

Number of colors Up to 16.8 million

Contrast ratio 200:1 (typical)

Brightness 180 nits (typical)

Backlight LED

Character display 80 × 25

Total power consumption 6.0 W

Viewing angle +/-65 horizontal, +/-50° vertical (typical)

Hard drive specifications
 750 GB* 500 GB* 320 GB*

Dimensions

Height 9.5 mm 9.5 mm 9.5 mm

Width 7.0 mm 7.0 mm 7.0 mm

Weight 101 g 101 g 101 g

Interface type SATA SATA SATA

Transfer rate 100 MB/sec 100 MB/sec 100 MB/sec

Security ATA security ATA security ATA security

Seek times (typical read, including setting)

Single track 3 ms 3 ms 3 ms

Average 13 ms 13 ms 13 ms

Maximum 24 ms 24 ms 24 ms

Logical blocks 1,250,242,867 976,752,240 625,121.433

Disk rotational speed 7200 rpm 7200 rpm 7200 rpm

Operating temperature 5°C to 55°C (41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive
specifications may differ slightly.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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Blu-ray R/RE DVD±RW SuperMulti Double-Layer Drive
specifications

Applicable disc Read: Write:

 BD-ROM, BD-ROM-DL, BD-R, BD-R-
DL, BD-RE, BD-RE-DL, DVD-ROM,
DVD+R, DVD+R-DL, DVD+RW, DVD-
R, DVD-R-DL, DVD-RW, DVD-RAM
(Ver.2), CD-DA, CD-ROM (mode 1 and
mode 2), CD-ROM XA (mode 2, form 1
and form 2), Photo CD (single and
multiple sessions), CD Extra, CD-R,
CD-RW, and CD-TEXT

DVD-RAM (Ver.2), DVD+R, DVD-R,
CD-R, and CD-ROM

Access time BD DVD

Random < 230 ms < 180 ms

Cache buffer 4.5 MB

Data transfer rate

2X BD-RAM 9 MB/sec

8X DVD 2,400 KB/sec

16X CD-R 2,400 KB/sec

16X CD-RW 2,400 KB/sec

Blu-ray ROM DVD±RW SuperMulti Double-Layer Drive
specifications

Applicable disc Read: Write:

 CD-DA, CD+(E)G, CD-MIDI, CDTEXT,
CD-ROM, CD-ROM XA,
MIXED MODE CD, CD-I, CD-I Bridge
(Photo-CD, Video CD), Multisession
CD (Photo-CD, CD-EXTRA, Portfolio,
CD-R, CD-RW), CD-R, CD-RW,
DVDROM (DVD-5, DVD-9, DVD-10,
DVD-18), DVD-R, DVD-RW, DVD+R,
DVD+RW, DVD-RAM, HD-
ROM (Single Layer), HD-ROM (Dual
Layer), HD DVD-R, HD DVD-R for
Dual Layer, HD DVD-RW

CD-R and CD-RW DVD+R, DVD+R(9),
DVD+RW, DVD-R, DVD-R(9),DVD-RW,
DVD-RAM

Access time CD DVD HD

Random 170 ms 170 ms 230 ms

Cache buffer 8 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD 10,800 KB/sec
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Applicable disc Read: Write:

24X CD-R 3,600 KB/sec

16X CD-RW 2,400 KB/sec

8X DVD+R 10,800 KB/sec

4X DVD+RW 5,400 KB/sec

8X DVD-R 10,800 KB/sec

4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9) 2,700 KB/sec

5X DVD-RAM 6,750 KB/sec

1X BD-ROM 4,500 KB/sec

1X BD-R read 4,500 KB/sec

1X BD-RE read 4,500 KB/sec

Transfer mode Multiword DMA Mode

DVD±RW SuperMulti Double-Layer Drive specifications
Applicable disc Read: Write:

 CD-DA, CD+(E)G, CD mIDI, CD-TEXT,
CD-ROM, CD-ROM XA, MIXED MODE
CD, CD-I, CD-I Bridge (Photo cD, Video
CD), Multisession CD, CD-EXTRA,
Portfolio, CD-R, CD-RW), CD-R, CD-
RW, DVD-ROM (DVD-5, DVD-9,
DVD-10, DVD-18), DVD-R, DVD-RW,
DVD+R, DVD+RW, DVD-RAM

CD-R and CD-RW

DVD+R, DVD+RW, DVD-R, DVD-RW,
DVD-RAM

Access time CD DVD

Random < 175 ms < 230 ms

Cache buffer 2.5 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD 10,800 KB/sec

24X CD-R 3,600 KB/sec

16X CD-RW 2,400 KB/sec

8X DVD+R 10,800 KB/sec

4X DVD+RW 5,400 KB/sec

8X DVD-R 10,800 KB/sec

4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9) 2,700 KB/sec
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Applicable disc Read: Write:

5X DVD-RAM 6,750 KB/sec

Transfer mode Multiword DMA Mode

DVD-ROM Drive specifications
Applicable disc Read: Write:

 CD-DA, CD+(E)G, CD mIDI, CD-TEXT,
CD-ROM, CD-ROM XA, MIXED MODE
CD, CD-I, CD-I Bridge (Photo cD,
Video CD), Multisession CD (Photo cD,
CDEXTRA, Portfolio, CD-R, CD-RW),
CDR, CD-RW, DVD-ROM (DVD-5,
DVD-9, DVD-10, DVD-18), DVD-R,
DVD-RW, DVD+R, DVD+RW, DVD-
RAM

CD-R and CD-RW

Access time CD DVD

Random < 110 ms < 130 ms

Cache buffer 2 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD 10,800 KB/sec

24X CD-R 3,600 KB/sec

16X CD-RW 3,600 KB/sec
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7 Backup and recovery

To protect your information, use Windows Backup and Restore to back up individual files and folders,
back up your entire hard drive (select models only), create system repair discs (select models only)
with the installed optical drive (select models only) or an optional external optical drive, or create
system restore points. In case of system failure, you can use the backup files to restore the contents
of your computer.

Windows Backup and Restore provides the following options:

● Creating a system repair disc (select models only) by using the installed optical drive (select
models only) or an optional external optical drive

● Backing up your information

● Creating a system image (select models only)

● Scheduling automatic backups (select models only)

● Creating system restore points

● Recovering individual files

● Restoring the computer to a previous state

● Recovering information using recovery tools

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

In case of system instability, HP recommends that you print the recovery procedures and save them
for later use.

NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. See Help and Support for more information.

Windows 7 — Backup and recovery
Creating recovery media with HP Recovery Disc Creator

HP Recovery Disc Creator is a software program that offers an alternative way to create recovery
media. After you successfully set up the computer, you can create recovery media using HP
Recovery Disc Creator. This recovery media allows you to reinstall your original operating system as
well as select drivers and applications if the hard drive becomes corrupted.

HP Recovery Disc Creator can create two kinds of recovery DVDs as follows:

● Windows DVD—Installs the operating system without additional drivers or applications.

● Driver DVD—Installs specific drivers and applications only, in the same way that the HP
Software Setup utility installs drivers and applications.
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Creating recovery media
NOTE: The Windows DVD can be created only once. Thereafter, the option to create that media will
not be available.

1. Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.

2. Select Driver DVD or Windows DVD.

3. From the drop-down menu, select the drive for burning the recovery media.

4. Click the Burn button to start the burning process.

Backing up your information
Recovery after a system failure is as good as your most recent backup. Immediately after setting up
the computer, you should create system repair discs (select models only) using the installed optical
drive (select models only) or an optional external optical drive and back up your system. As you add
new software and data files, you should continue to back up your system on a regular basis to
maintain a reasonably current backup. The system repair discs (select models only) are used to start
up (boot) the computer and repair the operating system in case of system instability or failure. Your
initial and subsequent backups allow you to restore your data and settings if a failure occurs.

You can back up your information to an optional external hard drive, a network drive, or discs.

Note the following when backing up:

● Store personal files in the Documents library, and back it up regularly.

● Back up templates that are stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

● When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend
on the type of optical drive you are using.

NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

● When backing up to discs, number each disc before inserting it into the external drive.

To create a backup using Backup and Restore:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of
the computer.

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to set up your backup, create a system image (select models
only), or create a system repair disc (select models only).

136 Chapter 7   Backup and recovery



Performing a system recovery
In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

● f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the
factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair
discs you previously created (select models only), you must purchase a Windows 7 operating system
DVD to reboot the computer and repair the operating system. For additional information, see the
Using a Windows 7 operating system DVD (purchased separately) section.

Using the Windows recovery tools

To recover information you previously backed up:

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to recover your system settings, your computer (select models
only), or your files.

To recover your information using Startup Repair, follow these steps:

CAUTION: Some Startup Repair options completely erase hard drive contents and reformat the
hard drive. All files you have created and any software installed on the computer are permanently
removed. When reformatting is complete, the recovery process restores the operating system, as well
as the drivers, software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Windows partition.

To check for the Windows partition, select Start > Computer.

3. If the Windows partition is listed, restart the computer, and then press f8 before the Windows
operating system loads.

4. Select Startup Repair.

5. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.

Using f11 recovery tools

CAUTION: Using f11 recovery tools completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently
removed. The f11 recovery tool reinstalls the operating system and HP programs and drivers that
were installed at the factory. Software not installed at the factory must be reinstalled.
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To recover the original hard drive image using f11:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: click Start, right-click
Computer, click Manage, and then click Disk Management.

NOTE: If the HP Recovery partition has been deleted, the f11 restore option will not function.
You must recover your operating system and programs using the Windows 7 operating system
DVD and the Driver Recovery disc (both purchased separately) if the Windows partition and the
HP Recovery partition are not listed. For additional information, see the Using a Windows 7
operating system DVD (purchased separately) section.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press
the ESC key for Startup Menu” message is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11>” for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.
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Using a Windows 7 operating system DVD (purchased separately)

To order a Windows 7 operating system DVD, go to the HP website. For U.S. support, go to
http:// www.hp.com/go/contactHP. For worldwide support, go to http://welcome.hp.com/country/us/en/
wwcontact_us.html. You can also order the DVD by calling support. For contact information, see the
Worldwide Telephone Numbers booklet included with the computer.

CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and
reformats the hard drive. All files you have created and any software installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 7 operating system DVD:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows 7 operating system DVD into the optical
drive before the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6. Select Repair your computer.

7. Follow the on-screen instructions.

After the repair is completed:

1. Eject the Windows 7 operating system DVD, and then insert the Driver Recovery disc.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.

Windows 8 — Backup and recovery
In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

● f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the
factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair
media you previously created (select models only), you must purchase Windows 8 operating system
media to reboot the computer and repair the operating system. For additional information, see

Using the Windows recovery tools
To recover information you previously backed up:

▲ From the Start screen, type h, and then select Help and Support.

To recover your information using Startup Repair, follow these steps:
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CAUTION: Some Startup Repair options will completely erase and reformat the hard drive. All files
you have created and any software installed on the computer are permanently removed. When
reformatting is complete, the recovery process restores the operating system, as well as the drivers,
software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition and the Windows partition.

From the Start screen, type e, and then click File Explorer.

– or –

From the Start screen, type c, and then select Computer.

NOTE: If the Windows partition and the HP Recovery partition are not listed, you must recover
your operating system and programs using the Windows 8 operating system DVD and the Driver
Recovery media (both purchased separately). For additional information, see Using Windows 8
operating system media (purchased separately) on page 141.

3. If the Windows partition and the HP Recovery partition are listed, restart the computer. After
Windows has loaded, press and hold the shift key while clicking Restart.

4. Select Troubleshoot, then select Advanced Options, and then select Automatic Repair.

5. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support. From the Start screen, type h, and then select Help and
Support.

Using f11 recovery tools
CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
that you have created and any software that you have installed on the computer are permanently
removed. The f11 recovery tool reinstalls the operating system and HP programs and drivers that
were installed at the factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: From the Start screen, type C,
and then select Computer.

NOTE: If the HP Recovery partition is not listed, you must recover your operating system and
programs using the Windows 8 operating system media and the Driver Recovery media (both
purchased separately). For additional information, see Using Windows 8 operating system
media (purchased separately) on page 141.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press
the ESC key for Startup Menu” message is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.
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Using Windows 8 operating system media (purchased separately)
To order a Windows 8 operating system DVD, go to http://www.hp.com/support, select your country
or region, and follow the on-screen instructions. You can also order the DVD by calling support. For
contact information, see the Worldwide Telephone Numbers booklet included with the computer.

CAUTION: Using a Windows 8 operating system media completely erases hard drive contents and
reformats the hard drive. All files that you have created and any software that you have installed on
the computer are permanently removed. When reformatting is complete, the recovery process helps
you restore the operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 8 operating system DVD:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows 8 operating system DVD into the optical
drive before the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

After the repair is completed:

1. Eject the Windows 8 operating system media and then insert the Driver Recovery media.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.
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Using Windows Refresh for quick and easy recovery
When your computer is not working properly and you need to regain system stability, the Windows
Refresh option allows you to start fresh and keep what is important to you.

IMPORTANT: Refresh removes any traditional applications that were not originally installed on the
system at the factory.

NOTE: During Refresh, a list of removed traditional applications will be saved so that you have a
quick way to see what you might need to reinstall. See Help and Support for instructions on
reinstalling traditional applications. From the Start screen, type h, and then select Help and Support.

NOTE: You may be prompted for your permission or password when using Refresh. See Windows
Help and Support for more information. From the Start screen, type h, and then select Help and
Support.

To start Refresh:

1. On the Start screen, point to the far-right upper or lower corner of the screen to display the
charms.

2. Click Settings.

3. Click Change PC settings in the bottom-right corner of the screen, and then select General
from the PC settings screen.

4. Under Refresh your PC without affecting your files, select Get started, and follow the on-
screen instructions.

Remove everything and reinstall Windows
Sometimes you want to perform detailed reformatting of your computer, or you want to remove
personal information before you give away or recycle your computer. The process described in this
section provides a speedy, simple way to return the computer to its original state. This option
removes all personal data, apps, and settings from your computer, and reinstalls Windows.

IMPORTANT: This option does not provide backups of your information. Before using this option,
back up any personal information you wish to retain.

You can initiate this option by using the f11 key or from the Start screen.

To use the f11 key:

1. Press f11 while the computer boots.

– or –

Press and hold f11 as you press the power button.

2. Select Troubleshoot from the boot options menu.

3. Select Reset your PC, and follow the on-screen instructions.

To use the Start screen:

1. On the Start screen, point to the far-right upper or lower corner of the screen to display the
charms.

2. Click Settings.
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3. Click Change PC settings in the bottom-right corner of the screen, and then select General
from the PC settings screen.

4. Under Remove everything and reinstall Windows, select Get started, and follow the on-
screen instructions.

Using HP Software Setup
HP Software Setup can be used to reinstall drivers or select software that has been corrupted or
deleted from the system.

1. From the Start screen, type HP Software Setup, and select Apps.

2. Open HP Software Setup.

3. Follow the on-screen directions to reinstall drivers or select software.

SUSE Linux — Backup and recovery
Recovery after a system failure is as good as your most recent backup. As you add new software and
data files, you should continue to back up your system on a regular basis to maintain a reasonably
current backup.

Performing a system recovery
Recovery allows you to repair or restore the computer to its original factory state. You can create an
HP factory image restore DVD, using an installed or an external DVD±RW optical drive. You can also
restore the computer to its factory condition from the HP dedicated recovery partition on the hard
drive.

CAUTION: Using Recovery completely erases hard drive contents and reformats the hard drive. All
files you have created and any software installed on the computer are permanently removed. The
recovery tool reinstalls the original operating system and HP programs and drivers that were installed
at the factory. Software, drivers, and updates not installed by HP must be manually reinstalled.
Personal files must be restored from a backup.

To restore the computer using the HP factory image restore DVD, you must first create the recovery
disc. To create the recovery disc:

NOTE: HP recommends that you create the HP factory image restore DVD in the event of a system
failure.

1. Select Computer > More Applications.

2. In the left pane, click Tools, and then click Create HP Factory Image Restore DVD in the right
pane.

3. Follow the on-screen instructions to create an image file to burn a recovery disc.

To restore the computer from the partition, follow these steps:

1. If possible, back up all personal files.

2. Insert the HP Factory Image Restore DVD into the external optical drive and restart the
computer.

3. As the computer is restarting, press f9 to open the Computer Setup boot option menu.

4. Select the Notebook Upgrade Bay option.
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5. Using the arrow keys, select Yes when prompted: Do you want to start the System-Restore?

6. Follow the on-screen instructions.

NOTE: You can also restore the computer from the partition by restarting the computer, and then
pressing the f11 key.

NOTE: If you are unable to boot (start up) your computer from the hard drive partition with the
primary operating system or from the recovery partition, and you did not create a system recovery
disc, you must purchase a SUSE Linux Enterprise Desktop Operating System DVD to reinstall the
operating system. For additional information, see the Worldwide Telephone Numbers booklet.

Backing up your information
You should back up your computer files on a regular schedule to maintain a current backup. You can
manually back up your information to an optional external drive, a network drive, or discs. Back up
your system at the following times:

● At regularly scheduled times

● Before the computer is repaired or restored

● Before you add or modify hardware or software

To back up your home directory files using Backup Manager Settings:

1. Select Computer > More Applications > Tools > Backup Manager Settings, and then click
the Backup my home directory button.

2. Click Storage Destination Location, and then select a location to back up your information.

3. Click Schedule, and then select a time schedule to perform backups at a regularly scheduled
time.

To immediately back up your information, click the Backup Now check box.

NOTE: Before you back up your information, be sure you have designated a location to save
the backup files.

4. Click the Save and Backup button to start the backup and to save the backup settings.

To restore backup files:

1. Select Computer > More Applications > Tools > Backup Manager Restore.

2. Click Backup Source, and then select the location of the backup files.

3. Click Restore Destination, and then select the destination to restore the files.

4. To restore all files from the selected location, click the Restore all files button. To restore
selective files only, click the Restore selected files button, and then click the Select Files
button and select the files to be restored.

5. Under Restore Point, click the time and date of the backup.

NOTE: If multiple backups have been performed, click the Use the latest version button to
restore the latest version.

6. Click the Restore button to start restoring the files, or click the Cancel button to cancel the
operation.
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8 Power cord set requirements

The wide-range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC, or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries
The following requirements are applicable to all countries and regions:

● The length of the power cord set must be at least 1.0m (3.3t) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.

Requirements for specific countries and regions
Country/region Accredited agency Applicable note number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China COC 5

South Korea EK 4
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Country/region Accredited agency Applicable note number

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region
where it will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall
plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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9 Recycling

When a non-rechargeable or rechargeable battery has reached the end of its useful life, do not
dispose of the battery in general household waste. Follow the local laws and regulations in your area
for battery disposal.

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and
rechargeable batteries. For more information about recycling programs, see the HP Web site at
http://www.hp.com/recycle.
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spare part numbers 36
docking support, product

description 4
drives, preventing damage 45
DVD-ROM Drive

precautions 45
spare part number 28, 32, 39,

64
specifications 134

DVD±RW and CD-RW SuperMulti
Double-Layer combo Drive

precautions 45
specifications 133

DVD±RW SuperMulti Double-
Layer Drive

spare part number 28, 31, 39,
63

specifications 133

E
electrostatic discharge 46
eSATA port, identifying 18
esc key, identifying 14
Ethernet, product description 3
ExpressCard slot

identifying 18
spare part number 33

ExpressCard socket
spare part number 35

external media cards, product
description 3

external monitor port 17

F
f11 recovery 140
fan

removal 116
spare part number 39, 116

fan/graphics board heat sink
assembly

removal 75
spare part number 26
spare part numbers 36, 40, 75

feet, locations 51
Fingerprint reader

spare part numbers 39
fingerprint reader

identifying 13
removal 93
spare part number 93

fn key, identifying 14, 15
function keys

identifying 14
function keys, identifying 15

G
graphics board

removal 115
spare part numbers 27, 39,

40, 115
graphics, product description 1
grounding equipment and

methods 48

H
hard drive

precautions 45
product description 2
removal 54, 56
spare part numbers 28, 31,

34, 35, 36, 54, 56
specifications 131

hard drive cover
removal 55

Hard Drive Hardware Kit
spare part number 33, 35

hard drive recovery 140
hard drive upgrade bay

spare part number 33
heat sink

spare part numbers 35
hinge

spare part number 30, 35
hinge cover

illustrated 30

I
integrated numeric keypad,

identifying 14, 15
integrated webcam light,

identifying 8, 9
internal display switch 8, 9
internal microphones, identifying

8, 9

J
jacks

audio in (microphone) 17
audio-out (headphone) 17
network 18
RJ-11 (modem) 19
RJ-45 (network) 18

K
keyboard

product description 4
removal 71
spare part numbers 23, 36,

37, 38, 40, 41, 42, 43, 71
keypad

integrated numeric 15
keypad, integrated numeric 14
keys

esc 14
fn 14, 15
function 14, 15
num lk 14
Windows applications 14
Windows button 14

L
latch kit

spare part number 39
latches, battery release 20
latches, service door release 20
legacy support, USB 118, 125
lights

battery 16
calculator 11
caps lock 11
mute 11
num lock 11
power 11, 16
TouchPad 11
Web browser light 11
webcam 8, 9
wireless 11, 16

lock, keyed cable
spare part number 34

lock, notebook combination
spare part number 34

M
mass storage device

spare part numbers 31
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mass storage device, spare part
numbers 28

Media Card reader, identifying 16
memory module

product description 1
removal 67, 69
spare part number 36
spare part numbers 26, 27,

35, 67, 69
microphone

product description 2
spare part number 30, 35

miscellaneous parts
spare part numbers 33

model name 1
modem module

product description 3
removal 97
spare part number 27, 34, 97

modem module cable
removal 100

mouse, laser
spare part number 36

mouse, travel
spare part number 34

mouse, wireless
spare part number 35

mute light, identifying 11

N
network cable

removal 107
spare part number 28

network jack, identifying 18
num lk key, identifying 14
num lock light 11

O
operating system, product

description 5
optical drive

identifying 17
precautions 45
product description 2
removal 63
spare part number 39
spare part numbers 28, 31, 63
specifications 132, 133, 134

optical drive bracket
spare part number 31

optical drive eject button,
identifying 17

P
packing guidelines 47
plastic parts 44
Plastics Kit

spare part number 35
pointing device

product description 4
pointing stick 10
pointing stick buttons 10
ports

1394 18
DisplayPort 18
eSATA 18
eSATA/USB 2.0 combo 18
external monitor 17
product description 4
USB 2.0 17, 18
USB charging 17

power button board
removal 91
spare part number 39, 91

power button, identifying 12
power connector cable

removal 107
spare part number 28

power connector, identifying 19
power cord

set requirements 145
spare part numbers 33, 34

power light 11, 16
power requirements, product

description 4
processor

product description 1
removal 112
spare part number 36
spare part numbers 26, 36,

40, 112
processor heat sink

removal 110
spare part number 35
spare part numbers 110

processor heat sink, spare part
numbers 27

processor,
spare pare numbers 36

product description
audio 2
chipset 1
display panel 1
docking support 4
Ethernet 3
external media cards 3
graphics 1
hard drives 2
keyboard 4
memory module 1
microphone 2
modem module 3
operating system 5
optical drives 2
pointing devices 4
ports 4
power requirements 4
processors 1
product name 1
security 5
serviceability 6
solid state drive 2
video 2
wireless 3

product name 1, 49
product number 49

R
recovery 142
recovery partition 140
recycle

computer 142
refresh 142
removal/replacement

preliminaries 44
procedures 49

remove everything and reinstall
Windows 142

reset
computer 142
steps 142

restoring the hard drive 140
RJ-11 (modem) jack, identifying

19
rj-11 modem cable

spare part numbers 28
RJ-45 (network) jack, identifying

18
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RTC battery
removal 63
spare part number 26, 35, 63

S
Screw Kit

spare part number 33, 39
security cable slot, identifying 18
security lock

removal 108
security, product description 5
sequential part numbers 34
serial number 49
service access cover

removal 52
spare part number 28, 52

service access door
spare part numbers 40

service considerations 44
service door release latch 20
service tag 49
serviceability, product

description 6
setup utility

navigating and selecting 118
restoring factory settings 119

SIM slot, identifying 20
SIM, removal 52
slots

ExpressCard 18
security cable 18
SIM 20

Smart Card
spare part number 39

Smart Card cover
spare part number 35

Smart Card reader
removal 58
spare part number 28, 58

solid-state drive
precautions 45
product description 2
spare part numbers 27, 32,

39, 40, 43
speaker assembly

removal 96
spare part number 35, 96

speakers, identifying 16

specifications
Blu-ray Disc ROM with

SuperMulti DVD±R/RW DL
Drive 132

Blu-ray R/RE DVD±RW
SuperMulti Double-Layer
Drive 132

computer 130
display 131
DVD-ROM Drive 134
DVD±RW SuperMulti Double-

Layer Drive 133
hard drive 131
optical drive 132, 133, 134

static-shielding materials 48
system board

removal 103
spare part number 39
spare part numbers 27, 40,

103

T
tools required 44
top cover

removal 83
spare part number 26, 39, 83

TouchPad
buttons 10
identifying 10
spare part number 26

TouchPad on/off button,
identifying 10, 12

TouchPad on/off light, identifying
11

transporting guidelines 47

U
upgrade bay

identifying 17
upgrade bay hard drive

removal 66
spare part number 66
spare part numbers 35

USB 3.0 board
spare part number 28

USB board
spare part number 40

USB legacy support 118, 125
USB port, identifying 17, 18

V
vents, identifying 18
video, product description 2
volume mute button, identifying

12

W
warranty period 49
Web browser light light 11
webcam 8, 9

removal 82
spare part number 29, 39, 82

webcam cable
spare part number 30, 35

webcam light, identifying 8, 9
webcam, identifying 8, 9
Windows

Refresh 142
reinstall 142
remove everything and reinstall

option 142
reset 142

Windows 8 operating system
DVD 141

Windows applications key,
identifying 14

Windows button, identifying 14
wireless

product description 3
wireless antenna

spare part number 35
wireless antennas, identifying 8
wireless button

identifying 12
wireless lights 11, 16
WLAN antenna and cables

spare part number 30
WLAN antennas, identifying 8, 9
WLAN module

removal 60
spare part numbers 27, 36, 60

workstation guidelines 47
WWAN antenna and cables

spare part number 30
WWAN antennas, identifying 8
WWAN module

removal 62
spare part numbers 27, 35, 62
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